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Πραγματικά νιώθεις μια ικανοποίηση όταν φτάνει
το τεύχος κοντά στην τελική του μορφή.

Ίσως κάποιες φορές κάποιοι να σκέφτονται τι εί-
ναι αυτό που κάνει μια ομάδα ανθρώπων διαφορετι-
κής ηλικίας, χαρακτήρα, επαγγέλματος και σίγουρα και
άλλα πολλά να ασχολούνται με κάτι που δεν αποφέ-
ρει χρήμα, “τρώει” κάποιο χρόνο από την ζωή τους πι-
θανόν να τους θεωρούν “κουζουλούς”, εξαρτημένους
από ένα πληκτρολόγιο, μια οθόνη το διαδίκτυο...

Στην σκληρή και συγχρόνως κενή πραγματικότητα
που ζούμε για τους περισσότερους είναι αδιανόητο
κάποιοι να συνεργάζονται χωρίς ΚΕΡΔΟΣ. Άς το σκε-
φτούμε λίγο ανάποδα.

Άν υπήρχε ΟΦΕΛΟΣ-ΧΡΗΜΑ-ΚΕΡΔΟΣ θα μπορού-
σαμε να είμαστε ομάδα χωρίς προστριβές, αντιζηλία,
συμφέρον; Μμμ, και με τον παράγοντα ΚΙΝΗΤΡΟ; ΕΚΕΙ
ακριβώς είναι η διαφορά.

Όλοι οι χρήστες Λίνουξ γνωρίζουμε ότι απολαμβά-
νουμε έναλειτουργικόπουαρκετοί έχουνδουλέψει και
συνεχίζουν να δουλεύουν. ΤΣΑΜΠΑ, ΔΩΡΕΑΝ πιο σω-
στά, ΕΛΕΥΘΕΡΑ είναι το σωστό.

Με οδηγό αυτή την ελευθερία στις 10 Μαΐου 2008
μια ομάδα Λινουξάδων ανέβασε το φόρουμ μας
http://forum.ubuntu-gr.org/. Μέλη που γράφτηκαν
στις 10 Μαίου 2008:
pkst, linuxman, bullgr, ktogias, nikosal, taratatzoum,
kaingeo, kostas, kamar, Puppet_Master, Alafolix,
ufuntu, PaPo, pkouvel, ale3andro.
Δεκαπέντε εγγραφές την πρώτη μέρα!
Την επόμενη μέρα ο αριθμός εγγραφών νέων μελών
είναι μεγαλύτερος:

diamond_gr, vaskoul, nono231, th1519, ilpara, soc2u,
john-s, ubuderix, sargirio, ulver, karanti, thanospap97,
simosx, ftso, john, stelios, brianovretanos, juanjo,
giormatsis, Liakoni, Dreadoulis, costasnikaia, mback23,
zissis, oBarbas, dimubuntix, cbouyio, kinesis, charnik,
jarlaxi, elefteria, erevnitis.
Δεύτερη μέρα και 32 εγγραφές, αριθμός ρεκόρ σε μια
μέρα ακόμα και για τα σημερινά δεδομένα. Έχουμε
φτάσει πάνω από 10600 εγγραφές και συνεχίζουμε...

Πριν από λίγες μέρες κυκλοφόρησε και η νέα έκ-
δοση της διανομής μας ,η Raring Ringtail 13.04 και
όπως το συνηθίζουμε κάναμε το release party στο Θη-
σείο.

Έχουμε να δούμε πολλές αλλαγές τους επόμενους
μήνες να συμβαίνουν που πιθανόν να αλλάξουν πολλά
στο Λίνουξ.

Έχει ήδη ανακοινωθεί αλλά και αναπτύσσεται από
την Canonical o MIR ο νέος display server που θα αντι-
καταστήσει ότι γνωρίζουμε μέχρι τώρα και θα περάσει
σε νέα γενιά και το Unity περιβάλλον.

Επίσης μεγάλη επανάσταση θα έρθει με την
Ubuntu έκδοση για φορητές συσκευές ,έξυπνα τη-
λέφωνα,ταμπλέτες, την Ubuntu Touch. Σίγουρα είναι
τρομερή κίνηση να φέρει τόσο κοντά το Λίνουξ στους
απανταχού χρήστες. Αναμένουμε με αγωνία τις εξελί-
ξεις.

Άς ξεκινήσουμε όμως την ανάγνωση του Ubuntista.

Από όλους μας,
Καλή ανάγνωση!

Γιώργος Μακρής
(ubuderix)
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H άδεια διάθεσης του περιεχομένου του Ubuntistas.

Τα άρθρα που περιλαμβάνονται στο περιοδικό διατίθενται υπό τη άδεια της Creative Commons Attribution-By-Share Alike
3.0 Unported license. Αυτό σημαίνει ότι μπορείτε να προσαρμόσετε, να αντιγράψετε, να διανείμετε και να διαβιβάσετε τα
άρθρα, αλλά μόνο υπό τους ακόλουθους όρους:
Πρέπει να αποδώσετε την εργασία στον αρχικό συντάκτη (π.χ. με αναφορά ονόματος, email, url) αλλά και στο περιοδικό,
αναφέροντας την ονομασία του (Ubuntistas).
Δεν επιτρέπεται να αποδίδετε το άρθρο/α με τρόπο που να το/α επικυρώνετεως δική σας εργασία. Και εάν κάνετε αλλαγές,
μεταβολές, ή δημιουργίες πάνω σε αυτήν την εργασία, πρέπει να διανείμετε την προκύπτουσα εργασία με την ίδια άδεια,
παρόμοια ή συμβατή.
Περίληψη άδειας: http://tinyurl.com/5nv7kn - Πλήρης άδεια: http://tinyurl.com/yqontc

To Ubuntu

Το Ubuntu GNU/Linux είναι ένα λειτουργικό σύστημα.
Με περιβάλλον εργασίας το Unity το φωνάζουμε Ubuntu,
με KDE το φωνάζουμε kubuntu. Είναι πλήρες(!), τεχνολο-
γικά προηγμένο(!) και εύκολο στην χρήση από οποιονδή-
ποτε(!). Στα αποθετήρια του Ubuntu υπάρχουν διαθέσι-
μες κυριολεκτικά χιλιάδες εφαρμογές σχεδόν για οτιδή-
ποτε(!)... για επαγγελματική, επιστημονική, εκπαιδευτική,
και οικιακή χρήση. Τόσο το Ubuntu όσο και οι εφαρμογές
του είναι Ελεύθερο Λογισμικό / Λογισμικό Ανοιχτού Κώ-
δικα (ΕΛ/ΛΑΚ), δηλαδή διατίθενται ελεύθερα, επιτρέπεται
η αντιγραφή, η διανομή ακόμα και η τροποποίησή τους
- και στην Ελλάδα υποστηρίζονται από την άτυπη αλλά
πολύ δραστήρια κοινότητα Ubuntu-gr. Περισσότερα στο
http://www.ubuntu-gr.org.

H κοινότητα Ubuntu-gr

Η κοινότητα ubuntu­gr ανήκει στα μέλη της και είναι ανοι-
χτή σε όλους! Eίναι το μέρος όπου έμπειροι και άπει-
ροι(!) χρήστες συζητάνε ό,τι τους απασχολεί, ιδέες, ερω-
τήματα, πρακτικά ζητήματα, οργανωτικά θέματα, και κυ-
ρίως τεχνικά προβλήματα. Αποτελείται από ανθρώπους
με εμπειρία στην πληροφορική αλλά κυρίως από απλούς
χρήστες, οι οποίοι εθελοντικά συμμετέχουν i) στην δη-
μιουργία­ανάπτυξη του λογισμικού, ii) στην μετάφρασή
του στην ελληνική γλώσσα, iii) στην προώθηση­διάδοση
του στην Ελλάδα, και κυρίως iv) στην παροχή αμεσό-
τατης(!) και υψηλής ποιότητας(!) τεχνικής υποστήριξης
σε άλλους ελληνόφωνους χρήστες. Λειτουργεί με αυτο-
οργάνωση και προσπαθούμε οι αποφάσεις να λαμβάνο-
νται όσο το δυνατόν πιο δημοκρατικά από εκείνους που
προσφέρουν­δραστηριοποιούνται συστηματικά. Η ελλη-
νική κοινότητα του Ubuntu διαθέτει μέχρι στιγμής φό-
ρουμ, λίστα ηλ. ταχυδρομείου, κανάλι συζητήσεων τύ-
που IRC, καθώς και το περιοδικό Ubuntistas. Για όλα αυτά
υπάρχουν οδηγίες και links στο http://www.ubuntu-gr.org.

Tο περιοδικό Ubuntistas

ΤοUbuntistas, τοηλεκτρονικόπεριοδικό της ελληνικής κοι-
νότητας του Ubuntu (Ubuntu-gr), κυκλοφορεί ελεύθερα
κάθεδίμηνο, με πρώτο τεύχος τουΝοεμβρίου-Δεκεμβρίου

2008. Περιέχει νέα, πληροφορίες, συνεντεύξεις,
ξεις, παρουσιάσεις, οδηγούς και άρθρασχετικά
με το Ubuntu. Το περιοδικό είναι ανοιχτό σε ό-
λους, όπως και το GNU/Linux! Ο καθένας μπο-
ρεί να συμμετέχει ενεργά στην δημιου-
ργία του, να αρθρογραφήσει, να
προτείνει ιδέες και να κάνει
τις επισημάνσεις / παρα-
τηρήσεις του.
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LibreOffice Writer – Γράψτε με στυλ (Μέρος 3ο) του Γιάννη Κωστάρα

Πρόλογος

Το πρόβλημα με τους κειμενογράφους WYSIWYG (What You See Is What

You Get) είναι ότι μας απασχολεί από πολύ νωρίς η τελική μορφή του εγ-

γράφου αντί να επικεντρωνόμαστε στο περιεχόμενό του. Με άλλα λόγια,

ενδιαφερόμαστε προτού καν τελειώσουμε τοάρθρομας για το πώςθαμορ-

φοποιήσουμε τις παραγράφους και τις επικεφαλίδες, αν θα χρησιμοποιή-

σουμε πλάγια ή έντονη γραφή, διαφορετική γραμματοσειρά (π.χ. για τμή-

ματα κώδικα—αν γράφετε σχετικά άρθρα όπως ο γράφων), κλπ. Το πρό-

βλημα είναι ότι, αν αργότερα αποφασίσετε (εσείς ή κάποιος άλλος) να αλ-

λάξετε π.χ. τη γραμματοσειρά Free Mono που χρησιμοποιήσατε για τη συγ-

γραφή κώδικα σε Ubuntu Mono, θα πρέπει να κάνετε χειροκίνητα την αλ-

λαγή σε ολόκληρο το κείμενο. Ή φανταστείτε ότι δίνετε το άρθρο στο αφε-

ντικό σας, ο οποίος σας το επιστρέφει ζητώντας σας να αντικαταστήσετε

παντού την έντονη γραφή με πλάγια, γιατί έτσι του αρέσει καλύτερα!

Σε αυτό το άρθρο θα δούμε πώς να γράφουμε πιο... συνετά, δηλ. αφή-

νοντας τη μορφοποίηση του κειμένου μας για το τέλος, χρησιμοποιώντας

στυλ.

Στυλ

Αφού τελειώσατε με το περιεχόμενο του άρθρου σας, ξεκινήστε με τη

μορφοποίησή του. Από το μενού Format→ Styles and Formatting ή το αντί-

στοιχο κουμπί της γραμμής εργαλείων μορφοποίησης (βλ. Εικόνα 1) εμφα-

νίστε το ανάλογο παράθυρο. Το LibreOffice διαθέτει πέντε κατηγορίες στυλ

(βλ. Εικόνα 2): παραγράφου, χαρακτήρα, πλαισίου, σελίδας και λίστας.

Εικόνα 1: Γραμμές Εργαλείων
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Εικόνα 2: Στυλ και μορφοποίηση

Ας υποθέσουμε ότι θέλετε να αλλάξετε την εξ ορισμού γραμματοσειρά
του εγγράφου σας, δηλ. τη γραμματοσειρά όλου του κειμένου. Επιλέξτε
Text Body από το παραπάνω παράθυρο, δεξί κλικ και Modify. Από το πα-
ράθυρο Paragraph Style: Text Body που εμφανίζεται, επιλέξτε την καρτέλα
Font, επιλέξτε τη γραμματοσειρά της αρεσκείας σας και OK. Η γραμματο-
σειρά ολόκληρου του κειμένου σας άλλαξε.

Εικόνα 3: Διαλογικό παράθυρο αλλαγής στυλ παραγράφου

Με τον ίδιο τρόπο επιλέξτε π.χ. μια επικεφαλίδα (heading) (το στυλ της
επιλέγεται αυτόματα στο παραπάνω παράθυρο) και επιλέξτε δεξί κλικ →
Modify για να το αλλάξετε. Όπως βλέπετε, υπάρχουν πολλά πράγματα που
μπορείτε να αλλάξετε, όπως η γραμματοσειρά, το μέγεθος και το χρώμα
της, η στοίχιση , το περίγραμμα, το διάκενο μεταξύ των γραμμών και πολλά
άλλα. Αφιερώστε λίγο χρόνο να δείτε τις διαθέσιμες κατηγορίες στυλ από
την πτυσσόμενη λίστα στο κάτω μέρος του παραθύρου της εικόνας 2.
Για να ορίσετε επικεφαλίδες επιλέξτε το κείμενο που θα περιέχει η επι-

κεφαλίδα και επιλέξτε Heading 1 από την πτυσσόμενη λίστα Apply Styles
που βρίσκεται αριστερά της πτυσσόμενης λίστας με τις γραμματοσειρές
στη γραμμή εργαλείων μορφοποίησης (βλ. Εικόνα 1). Οι υποκεφαλίδες θα
έχουν στυλ Heading 2, οι υπο-υποκεφαλίδες Heading 3 κ.ο.κ.
Ένας πιο εύκολος τρόπος για να αλλάξετε ένα υπάρχον στυλ είναι ο εξής:

τροποποιήστε το κείμενό σας (π.χ. με τη γραμματοσειρά που επιθυμείτε,
έντονη γραφή κλπ.), στη συνέχεια επιλέξτε το στυλ από το παράθυρο της
εικόνας 2 και τέλος επιλέξτε το πάνω δεξιά κουμπί του παραθύρου και την
επιλογή Update Style.
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Ας υποθέσουμε ότι θέλετε να δημιουργήσετε ένα νέο στυλ χαρακτήρα,
π.χ. το παρακάτω:
εδώ γράφω κώδικα

Επιλέξτε έναυπάρχονστυλπουμοιάζει με τοστυλπουθέλετε ναδημιουρ-
γήσετε (π.χ. το Text Body), δεξί κλικ και New. Το παράθυρο Character Style
σας ζητάει να εισάγετε ένα όνομα για το νέο στυλ. Δώστε Code. Επιλέξτε
την καρτέλα Font και επιλέξτε τη γραμματοσειρά FreeMono και μέγεθος 11
(ένα λιγότερο από του κειμένου σας). Επιλέξτε την καρτέλα Background και
το μαύρο χρώμα. Τέλος, επιλέξτε την καρτέλα Font Effects και Font Color
είτε λευκό είτε αυτόματο. Πατώντας OK δημιουργήσατε το νέο σας στυλ,
το οποίο μπορείτε πλέον να αναζητήσετε στο παράθυρο της εικόνας 2. Για
να το εφαρμόσετε σε ένα κείμενο, επιλέξτε το και στη συνέχεια κάντε διπλό
κλικ πάνω στο στυλ. Εναλλακτικά, επιλέξτε το στυλ, κάντε κλικ στο κουμπί
Fill Format Mode του ίδιου παραθύρου και επιλέξτε το κείμενο που θέλετε
να μορφοποιήσετε. Το στυλ ενημερώνεται με τις αλλαγές που κάνατε στο
κείμενο. Δυστυχώς, στην περίπτωσή μας θέλουμε το μαύρο φόντο να κα-
λύπτει όλο το πλάτος της παραγράφου, άρα το παραπάνω στυλ χαρακτή-
ρων δεν αρκεί. Οπότε, δημιουργήστε με τον ίδιο τρόπο και ένα στυλ παρα-
γράφου, ορίζοντας επιπλέον τη στοίχιση της παραγράφου σε αριστερή. Στη
συνέχεια θέλουμε η επόμενη παράγραφος να έχει το απλό στυλ κειμένου
(δηλ., όταν πατήσουμε ΕΝΤΕR για να εισάγουμε την επόμενη παράγραφο
του εγγράφου μας, αυτή να αποκτήσει αυτόματα στυλ απλού κειμένου κι
όχι στυλ κώδικα). Στην καρτέλα Organizer ορίστε Next Style → Text body.
Αν συνδέσετε δυο στυλ μέσω Linked with, τότε ό,τι αλλαγές κάνετε στο ένα
από αυτά θα εφαρμόζονται αυτόματα και στα συνδεδεμένα στυλ.Μπορείτε
να δείτε την ιεραρχία των στυλ επιλέγοντας Hierarchical από την πτυσσό-
μενη λίστα στο κάτω μέρος του παραθύρου της εικόνας 2.

Θα πρέπει επομένως να εφαρμόσετε και τα δυο στυλ (παραγράφου και
χαρακτήρων) στο κείμενό σας για να έχετε το παραπάνω αποτέλεσμα μορ-
φοποίησης κώδικα. Μπορείτε όμως, αφού τα εφαρμόσετε μια φορά, να
χρησιμοποιείτε το πινέλο μορφοποίησης (βλ. Εικόνα 2) για να τα εφαρμό-
ζετε σε επόμενα σημεία του εγγράφου σας. Κάντε κλικ στο σημείο του κει-
μένου όπου έχετε ήδη εφαρμόσει τα παραπάνω στυλ Code, στη συνέχεια
κλικ στο κουμπί πινέλο μορφοποίησης (format paintbrush), και τέλος επι-
λέξτε τοκείμενοπουθέλετε ναμορφοποιήσετε. Τονέοκείμενομορφοποιεί-
ται όπως και το αρχικό.

Το καλό με τα στυλ είναι ότι από τη στιγμή που τα δημιουργή-

σατε/τροποποιήσατε είναι διαθέσιμα σε όλα τα έγγραφά σας.
Σε μεγάλα κείμενα είναι πολύ δουλειά να αφήνετε τη μορφοποίηση για

το τέλος. Σ’ αυτήν την περίπτωση μπορείτε να μορφοποιείτε το κείμενό σας
καθώς το γράφετε, εφαρμόζοντας όμως τα στυλ, όπως μάθαμε. Έτσι, όταν
τελειώσετε με τη συγγραφή του άρθρου και δεν είστε π.χ. ικανοποιημένος/-
η με τη γραμματοσειρά ή τη στοίχιση των επικεφαλίδων, μπορείτε να τρο-
ποποιήσετε τις επικεφαλίδες όλου του εγγράφου από το παράθυρο της ει-
κόνας 2, όπως μάθαμε.

Πρότυπα εγγράφων

Μπορείτε να δημιουργήσετε ένα πρότυπο εγγράφου (template), το οποίο
θα περιέχει τις μορφοποιήσεις και τα στυλ της αρεσκείας σας, και κάθε
φορά να δημιουργείτε τα κείμενα σας με βάση αυτό το πρότυπο.
Δημιουργήστε ένα κενό έγγραφο και προσθέστε τις μορφοποιήσεις και

τα στυλ σας σε δείγματα κειμένου, όπως λεζάντες, παραπομπές, επικεφαλί-
δες (headings), κεφαλίδες (headers) και υποσέλιδα.
Έστω ότι θέλετε να δημιουργήσετε ένα βιβλίο. Αφού ορίσετε τα παρα-

πάνω στυλ, κάντε κλικ στο κουμπί στυλ σελίδων (βλ. Εικόνα 2) και τροπο-
ποιήστε τα διαθέσιμα στυλ σελίδων (π.χ. μπορείτε να ορίσετε διαφορετικά
στυλ σελίδων για εξώφυλλο, copyright, πίνακα περιεχομένων, πρόλογο, κε-
φάλαια και αλφαβητικό ευρετήριο). Το στυλ μπορεί να είναι διαφορετικό
για την πρώτη σελίδα κάθε κεφαλαίου, καθώς και για τις αριστερές και τις
δεξιές σελίδες (π.χ. για να μείνει χώρος για τη βιβλιοδεσία, εφόσον το βι-
βλίο θα εκτυπωθεί μπρος-πίσω). Έτσι, αν θέλετε κάθε νέο κεφάλαιο να ξε-
κινάει σεδεξιάσελίδα, επιλέξτε First Page→Modify→ καρτέλαPage→Page
Layout: Only Right. Στην καρτέλα Organizer ορίστε το Next Style: Left Page.
Στη συνέχεια, ανοίξτε το στυλ της αριστερής σελίδας, κάντε όποιες αλλαγές
θέλετε, και μην ξεχάσετε να ορίσετε το Next Style: Right Page. Αντίστοιχα,
στο στυλ της δεξιάς σελίδας επιλέξτε Next Style: Left Page.
Τώρα μπορείτε να αποθηκεύσετε το έγγραφόσαςως πρότυπο: μενού File

→ Templates→ Save→MyTemplates, δίνοντας ένα όνομα και OK. Την επό-
μενη φορά που θα θελήσετε να δημιουργήσετε ένα έγγραφο με τα αγαπη-
μένα σας στυλ και μορφοποιήσεις πηγαίνετε μενού File→New→ Templates
and Documents→MyTemplates, επιλέγετε το πρότυπό σας καιOpen, και ξε-
κινάτε τη συγγραφή του άρθρου σας με βάση αυτό το πρότυπο.
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Πίνακας περιεχομένων και ευρετήρια

Ανορίσατε τις επικεφαλίδες του εγγράφουσας χρησιμοποιώντας ταστυλ
Heading 1, Heading 2, κ.ο.κ., όπως περιγράψαμε παραπάνω, τότε μπορείτε
να δημιουργήσετε έναν πίνακα περιεχομένων. Κάντε κλικ στην αρχή του εγ-
γράφου σας (ή όπου επιθυμείτε να προσθέσετε τον πίνακα περιεχομένων)
και επιλέξτε Insert→ Indexes and Tables→ Indexes and Tables. Εμφανίζεται
το παράθυρο της εικόνας 4. Επιλέξτε την καρτέλα Index/Table, τύπο Table
of Contents, δώστε έναν τίτλο για τον πίνακα περιεχομένων σας (π.χ. “Πί-
νακας Περιεχομένων”) και πατήστε OK. Μπορείτε να ενημερώνετε τον πί-
νακα περιεχομένων με τις αλλαγές του εγγράφου σας κάνοντας δεξί κλικ
πάνω του και επιλέγοντας Update Index/Table. Άλλες διαθέσιμες επιλογές
είναι οι Edit Index/Table (εμφάνιση του παραθύρου της εικόνας 4) καιDelete
Index/Table.

Εικόνα 4: Πίνακας περιεχομένων

Από το ίδιο μενού μπορείτε να προσθέσετε λίστα εικόνων, πινάκων, κλπ.
Απλά, επιλέξτε τον κατάλληλο τύπο από την πτυσσόμενη λίστα Type. Θα
πρέπει όμως πρωτύτερα να έχετε δηλώσει λεζάντες για τις εικόνες, τους

πίνακες, κλπ.
Αλλά ας πάρουμε τα πράγματα με τη σειρά. Για να εισάγετε μια εικόνα

στο έγγραφό σας επιλέξτε Insert→ Picture→ From File, επιλέξτε την εικόνα
σας και OK. Στη συνέχεια κάντε δεξί κλικ στην εικόνα και επιλέξτε Caption.
Εμφανίζεται διαλογικό παράθυρο της παρακάτω εικόνας.

Εικόνα 5: Εισαγωγή Λεζάντας

Εισάγετε το περιεχόμενο της λεζάντας στο πρώτο πλαίσιο κειμένου. Επί-
σης, μπορείτε να ορίσετε την ίδια τη λεζάντα, γράφοντας στο πλαίσιο
Category (όπως φαίνεται στην εικόνα 5). Μπορείτε ακόμα να ορίσετε τη
θέση (δηλ. πάνω ή κάτω από την εικόνα), κλπ.
Αφού δημιουργήσετε λεζάντες για όλες τις εικόνες σας, μπορείτε να δη-

μιουργήσετε ένα ευρετήριο εικόνων όπως περιγράψαμε στην αρχή αυτής
της ενότητας (επιλέγοντας τον τύπο Illustration Index).
Παρομοίως, μπορείτε να εισάγετε έναν πίνακα είτε από το μενού Table→

Insert Table, είτε από το κουμπί Table της βασικής γραμμής εργαλείων (βλ.
Εικόνα 1) – θα αφιερώσουμε ολόκληρο άρθρο για τους πίνακες σε επόμενο
τεύχος. Και στις δυο περιπτώσεις ορίστε τον αριθμό γραμμών και στηλών
του πίνακα. Στη συνέχεια, όπως και με τις εικόνες, κάντε δεξί κλικ πάνωστον
πίνακα και επιλέξτε Caption. Τροποποιήστε τη λεζάντα του πίνακα κατά τον
ίδιο τρόπο όπως περιγράψαμε και πιο πάνω για τις εικόνες. Τέλος, δημιουρ-
γήστε ένα ευρετήριο πινάκων όπως περιγράψαμε στην αρχή αυτής της ενό-
τητας (επιλέγοντας τον τύπο Index of Table).
Το LibreOffice σας δίνει τη δυνατότητα να δημιουργήσετε ακόμα και αλ-

7



φαβητικό ευρετήριο (κάτι που λείπει παρεμπιπτόντως από πολλά ελληνικά
βιβλία του εμπορίου). Επιλέξτε τη λέξη που θέλετε να εμφανιστεί στο ευ-
ρετήριο και κάντε κλικ στο μενού Insert → Indexes and Tables → Entry →
Insert. Αφούολοκληρώσετε την επιλογή τωνλέξεων του ευρετηρίου, τοαλ-
φαβητικό ευρετήριο δημιουργείται όπως και προηγουμένως (επιλέγοντας
τον τύπο Alphabetical Index.)

Παραπομπές

Μερικές φορές ενδέχεται να χρειαστεί να παραπέμψετε τον αναγνώστη
σας σε κάποια εικόνα, κάποιο πίνακα ή κάποιο άλλο μέρος του κειμένου, π.χ.
επικεφαλίδα, σελιδοδείκτη, κλπ. Π.χ. «όπως φαίνεται στην εικόνα 2...». Για
να παραπέμψετε στην εικόνα 2 επιλέξτε το μενού Insert→ Cross Reference
και από το διαλογικό παράθυρο που εμφανίζεται (βλ. Εικόνα 6) επιλέξτε
Type: Εικόνα, Insert reference to: Category andNumber, την παραπομπή που
επιθυμείτε (δηλ. Εικόνα 1 από το πλαίσιο Selection), και τέλος Insert. Όπως
βλέπετε, μπορείτε ναδημιουργήσετε παραπομπές σε επικεφαλίδες, αναφο-
ρές, σελιδοδείκτες, εικόνες, πίνακες, κλπ.

Εικόνα 6: Εισαγωγή παραπομπής

Καθώς προσθαφαιρείτε εικόνες, πίνακες, κλπ. στο κείμενό σας, οι αύξο-
ντες αριθμοί των λεζάντων, παραπομπών, κλπ. ενημερώνονται αυτόματα.

Σελιδοδείκτες

Μιας και αναφέρθηκε, και για να είναι πλήρες το άρθρο, μπορείτε να δη-
μιουργήσετε σελιδοδείκτες από το μενού Insert→ Bookmark. Γενικά, χρησι-
μοποιήστε τους σελιδοδείκτες για κείμενο που δεν καλύπτεται από τις άλ-
λες κατηγορίες (επικεφαλίδες, λεζάντες κλπ.), αλλά προς το οποίο θέλετε να
παραπέμψετε. Για να παραπέμψετε σε έναν σελιδοδείκτη επιλέξτε και πάλι
Insert→ Cross Reference (βλ. Εικόνα 6). Τέλος, μπορείτε να επεξεργαστείτε
ή/και να διαγράψετε τους σελιδοδείκτες από το ίδιο διαλογικό παράθυρο
από όπου τους προσθέσατε (βλ. Εικόνα 7).

Εικόνα 7: Διαχείριση σελιδοδεικτών
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Σημεία προσάρτησης (mount points). Τί εννοούμε με αυτή τη φράση;
Πώς χρησιμοποιούνται στο GNU/Linux; του Φίλιππου (fkol k4)

Είναι συχνό το φαινόμενο, διαβάζοντας κάτι σχετικά με το Ubuntu μας

(ή γενικότερα το GNU/Linux) να βρισκόμαστε αντιμέτωποι με αυτόν τον

όρο. Όπως είναι λογικό, ένας νέος χρήστης δυσκολεύεται να κατανοήσει

πλήρως τις έννοιες «προσάρτηση» και «σημείο προσάρτησης», μιας και στο

Microsoft Windows του οποίου πιθανότατα ήταν αποκλειστικός χρήστης

ως πρόσφατα, αυτός ο όρος δεν χρησιμοποιείται, αν και πιθανότατα

υπάρχει.

Σε αυτό το αρθράκι, θα γίνει προσπάθεια να εξηγηθεί αυτός ο όρος με

όσο το δυνατόν πιο απλή γλώσσα και όσο το δυνατόν λιγότερους τεχνικούς

όρους ώστε να γίνει κατανοητός ακόμη και στον αρχάριο χρήστη.

-Τί εννοούμε λοιπόν λέγοντας «προσάρτηση»;

Το ρήμα «προσαρτώ», σημαίνει «κάνω δικό μου, κτήμα μου, χρίζω ως

τμήμα μου». Το ίδιο ακριβώς εννοούμε και όταν αναφερόμαστε στο λει-

τουργικό μας σύστημα. Προσαρτώντας δηλαδή έναν τόμο (ένας τόμος για

παράδειγμα μπορεί να είναι ένα στικάκι USB με φωτογραφίες, ένας εξωτερι-

κός σκληρός δίσκος, το διαμέρισμα (partition) όπου βρίσκεται το Microsoft

Windows αν έχουμε εγκατάσταση Dual Boot στον υπολογιστή μας ή ακόμα και

το διαμέρισμα του χρήστη μας αν έχουμε ορίσει ξεχωριστό χώρο για το /home

διαμέρισμα όπως πολλοί οδηγοί εγκατάστασης προτείνουν), τον ενσωματώ-

νουμε στο λειτουργικό μας σύστημα, τον κάνουμε δηλαδή κομμάτι του.

Αυτό είναι απαραίτητο αν θέλουμε να δούμε το περιεχόμενο ενός τόμου ή

ενός φακέλου με αρχεία, καθώς για να μπορέσουμε να δούμε κάτι, θα πρέ-

πει αυτό να είναι κομμάτι του λειτουργικού μας συστήματος. Αυτό ισχύει

φυσικά και στο Microsoft Windows.

-Εντάξει λοιπόν με την προσάρτηση, αλλά τι εννοούμε

όταν λέμε «σημείο προσάρτησης»;

Σημείο προσάρτησης, λέγεται χοντρικά η ταμπέλα που βάζει το λειτουρ-

γικό σε έναν τόμο ή φάκελο όταν τον προσαρτά, ώστε να ξέρουμε πού να

ψάξουμε για να δούμε το περιεχόμενό του.

Το ίδιο γίνεται και στο Microsoft Windows. Όταν για παράδειγμα συν-

δέσουμε έναν εξωτερικό δίσκο, αυτός θα πάρει ένα όνομα όπως “D:\”,

“E:\” και στους φακέλους που βρίσκονται μέσα του προστίθεται στην αρχή

το σημείο αυτό. Έτσι, αν έχουμε έναν φάκελο με όνομα «τραγούδια» σε

ένα στικάκι, όταν το συνδέσουμε αυτός ο φάκελος θα ονομάζεται πλέον

“D:\τραγούδια\”.

Στο Ubuntu - GNU/Linux αντίθετα, το όνομα της ταμπέλας αυτής μπο-

ρούμε είτε να το ορίσουμε εμείς, είτε να αφήσουμε το λειτουργικό σύστημα

να το κάνει για εμάς, σύμφωνα με τις ρυθμίσεις που έχει κάνει η ομάδα ανά-

πτυξής του (στην περίπτωση του Ubuntu, η Canonical).
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-Πώς χρησιμοποιούνται τα σημεία προσάρτησης στο

Ubuntu (ή το GNU/Linux γενικότερα);

Αυτό που πρέπει να έχουμε υπόψη μας, είναι πως στο Ubuntu (και το
GNU/Linux γενικότερα), υπάρχει μια τάση να ταξινομούνται όλα τα δεδο-
μένα, ανάλογα με το πώς τα χρησιμοποιεί το λειτουργικό μας σύστημα, έτσι
ώστε τα πάντα να είναι νοικοκυρεμένα. Ο τρόπος που χρησιμοποιείται γι
αυτό, μοιάζει σχηματικά με τον παρακάτω:
Ας φανταστούμε λοιπόν πώς θα μπορούσε να είναι φτιαγμένο ένα ξε-

νοδοχείο, ας το ονομάσουμε το ξενοδοχείο “Ubuntu”.

Εικόνα 1: Ξενοδοχείο “Ubuntu”

Για να μπούμε λοιπόν στο ξενοδοχείο-λειτουργικό μας σύστημα, θα πρέ-
πει να περάσουμε από το κεντρικό σαλόνι (lobby), από όπου θα μπορούμε
να επισκεφθούμε κάθε σημείο του ξενοδοχείου-λειτουργικού συστήματος.
Αφού λοιπόν από εκεί μπορούμε να πάμε παντού, είναι το κεντρικό σημείο
του ξενοδοχείου-λειτουργικού μας, το οποίο στα GNU/Linux λειτουργικά
όπως το Ubuntu, το συμβολίζουμε με την κάθετο ( slash - / ) και το ονομά-
ζουμε ρίζα ή ριζικό φάκελο.

Κάθεφάκελος πουβρίσκεται μέσαστοριζικόφάκελο, μοιάζει και με έναν
όροφο του ξενοδοχείου-λειτουργικού μας συστήματος και έχει και από ένα
ξεχωριστό, δικό του όνομα (όπως για παράδειγμα usr, tmp, etc, home κτλ.).

Αυτό λοιπόν το όνομα, καθορίζει και το σημείο προσάρτησης, που δεν
είναι τίποτα άλλο από το όνομα του φακέλου προσθέτοντας και το πού
βρίσκεται. Δηλαδή, όπως θα λέγαμε «ο πρώτος όροφος του ξενοδοχείου
Ubuntu», έτσι θα πούμε «ο φάκελος etc που βρίσκεται μέσα στο ριζικό φά-
κελο». Αυτό για παράδειγμα, το συμβολίζουμε ως /etc. Αν θα θέλαμε να
βρούμε λοιπόν ένα αρχείο που βρίσκεται μέσα στον φάκελο etc, τότε το
λειτουργικό μας σύστημα θα ψάξει στο σημείο προσάρτησης /etc.

-Ωραία, αλλά σε τι χρησιμεύει να τα ξέρουμε αυτά;

Η χρησιμότητα βρίσκεται στο ότι μπορούμε να κάνουμε ανεξάρτητα με-
ταξύ τους αυτά τα σημεία και αν θέλουμε να χρησιμοποιούμε για το καθένα
απόαυτά ξεχωριστάδιαμερίσματα, ήακόμακαι ξεχωριστούςδίσκους. Κατά
αντιστοιχία, τα δωμάτια του ξενοδοχείου μας να μην είναι όλα σε ένα με-
γάλο κτίριο αλλά σε πολλά μικρότερα, ωστόσο να ανήκουν ακόμη στο ίδιο
ξενοδοχείο.

Όταν για παράδειγμασυνδέουμε έναUSB stick με τραγούδια στον υπολο-
γιστή μας, τότε το Ubuntu για να μπορέσει να τα διαβάσει, δημιουργεί αυ-
τόματα ένα σημείο που λέγεται /media και τοποθετεί το στικάκι εκεί. Έτσι,
αν θέλουμε να παίξουμε τα τραγούδια στο στικάκι, το λειτουργικό θα ψάξει
στο σημείο /media. Αντίστοιχα, αν θέλαμε να προσθέσουμε έξτρα δωμάτια
στο ξενοδοχείο μας, θα χτίζαμε ένα επιπλέον κτίριο και θα τα βάζαμε εκεί.

Ένα άλλο παράδειγμα είναι όταν κάποιοι μας συστήνουν κατά την εγκατά-
σταση τουUbuntu να χρησιμοποιούμε ξεχωριστό διαμέρισμα για το σημείο
/home. Τι σημαίνει αυτόστην πράξη;Ότι μπορούμε να κάνουμε μια ρύθμιση
και να λέμε στο λειτουργικό μας «για το σημείο προσάρτησης /home, να χρη-
σιμοποιείς αυτό το ξεχωριστό κομμάτι του δίσκου». Αυτό, θα κάνει το Ubuntu
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– GNU/Linux μας, όταν θέλει να βρει κάτι που έχουμε μέσα στο σημείο αυτό,
να μην ψάχνει στο ίδιο κομμάτι του δίσκου που είναι και όλα τα υπόλοιπα,
αλλά στο ξεχωριστό που του είπαμε.

Κοιτάξτε πως έχει γίνει τώρα το ξενοδοχείο-λειτουργικό μας σύστημα:

Εικόνα 2: Ξενοδοχείο “Ubuntu”

-Το /home είναι αυτό που λέμε προσωπικός φάκελος,

έτσι;

Σχεδόν. Το /home είναι το σημείο που μέσα του βρίσκεται ο προσωπικός
μας φάκελος. Το αντίστοιχο δηλαδή του κτιρίου που ονομάσαμε home στην
παραπάνω φωτογραφία. Αν ανοίξουμε το διαχειριστή αρχείων μας και ψά-
ξουμε μέσα στο σημείο /home, θα βρούμε ένα φάκελο που έχει το όνομα
του χρήστη που φτιάξαμε όταν κάναμε την εγκατάσταση του Ubuntu. Αυ-

τός ο φάκελος, είναι ο προσωπικός μας φάκελος και μέσα του υπάρχουν οι
γνωστοί φάκελοι με τις φωτογραφίες, τα έγγραφά μας, τις ρυθμίσεις μας
κτλ.

Αν μοιραζόμαστε με κάποιον ακόμη τον υπολογιστή μας, μπορούμε να
φτιάξουμε και έναν δεύτερο χρήστη, ώστε να έχουμε ξεχωριστά έγγραφα,
ρυθμίσεις, φωτογραφίες κτλ ο καθένας.

Αν τότε κοιτάξουμε ξανά μέσαστοσημείο /home, θα δούμε πως δημιουρ-
γήθηκε άλλος ένας φάκελος με το όνομα του δεύτερου χρήστη αυτή τη
φορά. Αυτός θα είναι ο προσωπικός φάκελος του δεύτερου χρήστη που δη-
μιουργήσαμε. Το αντίστοιχο για το ξενοδοχείο θα ήταν τα δωμάτια που βρί-
σκονται μέσα στο κτίριο με όνομα home.

Έτσι λοιπόν, βλέπουμε ότι το σημείο /home είναι το σημείο που συγκε-
ντρώνονται οι προσωπικοί φάκελοι όλων των χρηστών που δημιουργούμε.

-Αυτά τα σημεία έχουν στάνταρ ονόματα, ή πρέπει να

βάζω δικά μου;

Υπάρχουν κάποια στάνταρ ονόματα, αλλά μπορούμε να βάζουμε και δικά
μας αν θέλουμε. Υπάρχουν κάποια ονόματα που χρησιμοποιούνται πάντα
έτσι κι αλλιώς, για τα δεδομένα που υπάρχουν σε μία εγκατάσταση, όπως
πχ τα προγράμματα και οι ρυθμίσεις τους. Για παράδειγμα, δεν θα λείπουν
ποτέ τα /etc, /home, /tmp και κάποια άλλα. Επίσης, υπάρχουν σημεία
με στάνταρ ονόματα που χρησιμοποιεί αυτόματα το Ubuntu μας, όπως
το /media αλλά και κάποια ονόματα σημείων που χρησιμοποιούν πολλοί
χρήστες παραδοσιακά και έχουν μείνει, όπως το /mnt. Μπορούμε όμως
αν θέλουμε να φτιάξουμε κι ένα δικό μας. Αν για παράδειγμα έχουμε έναν
δεύτερο δίσκο στον υπολογιστή μας γεμάτο MP3 τραγούδια, μπορούμε να
φτιάξουμε ένα σημείο προσάρτησης με δικό μας όνομα και να το πούμε
/MP3, οπότε να ξέρουμε πως όλα μας τα τραγούδια βρίσκονται στο σημείο
αυτό.

Ελπίζω με αυτό το μικρό άρθρο να κάλυψα κάποιες από τις βασικότερες
απορίες σας για τα σημεία προσάρτησης και το πώς μπορούμε να τα χρησι-
μοποιήσουμε.
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FreeDOS: ”DOS από τα παλιά με αέρα ελευθερίας” του Γιώργου Μακρή

Τι είναι αυτό το FreeDOS;

Είναι λειτουργικό σύστημα; Είναι ελεύθερο, ανοικτού κώδικα; Αυτά εί-

ναι κάποια ερωτήματα που εύλογα μπορούμε να έχουμε. Πολλοί από εμάς

έχουμε συναντήσει από παλιά το DOS και για την ακρίβεια το MS-DOS.

Το FreeDOS ξεκίνησε τον Ιούνιο του 1994, σχεδόν αμέσως μετά την ανα-

κοίνωση διακοπής ανάπτυξης και υποστήριξης από την Microsoft.

FreeDOS

Το FreeDOS είναι πραγματικά ένα ΕΛΕΥΘΕΡΟ DOS συμβατό με το λει-

τουργικό σύστημα που τρέχουμε στον υπολογιστή μας. Είναι μια εξέλιξη

του παλαιού DOS που μας επιτρέπει την πρόσβαση σε παλαιά συστήματα

αρχείων FAT32 για την υποστήριξη μεγάλων δίσκων LBA, κάτι που δεν μπο-

ρεί να εφαρμοστεί στο MS-DOS που περιλαμβάνεται σε εκδόσεις Windows

95 και μεταγενέστερες.

Λήψη & Εγκατάσταση

Όπως έγραψα παραπάνω, είναι ελεύθερο, μπορούμε να το κατεβάσουμε

δωρεάν από τον ιστότοπό του http://www.freedos.org, είναι λογισμικό ανοι-

κτού κώδικα και τα προγράμματα που περιλαμβάνει διέπονται από την

άδεια GNU General Public License (GNU GPL).

“-Μπορούμε να προσφέρουμε ;

-Φυσικά, επειδή είναι λογισμικό ανοικτού πηγαίου κώδικα, όποιος γνωρίζει

μπορεί να συμβάλει στον κώδικά του.

-Αν δεν ξέρουμε να γράφουμε κώδικα, υπάρχει άλλος τρόπος;

-Μα και βέβαια.

Όλοι οι χρήστες μπορούν να κάνουν αναφορές στα σφάλματα

http://sourceforge.net/tracker/?!group_id=5109&atid=105109 που τυ-

χόν θα συναντήσουν, κάτι που θα βοηθήσει τους προγραμματιστές να το

διορθώσουν άμεσα, προς όφελος όλων.

Το FreeDOS μπορεί να τρέξει και να εγκατασταθεί από το cd-rom σε υπο-

λογιστές, αλλά και ως λειτουργικό με τη δημιουργία εικονικής μηχανής σε

όλες τις πλατφόρμες (Linux, Windows, Mac).

Ας δούμε παρακάτω ένα σύντομο οδηγό εγκατάστασης σε εικονική μη-
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χανή:

1. Κατεβάζουμε το FreeDOS από τη σελίδα http://www.freedos.org/
download/ και γράφουμε το αρχείο σε ένα cd.

2. Ξεκινώντας, θα πρέπει να έχουμε εγκαταστήσει στο λειτουργικό μας το
VirtualBox.

Αυτό μπορεί να γίνει με 2 τρόπους:

• Μέσω του Κέντρου λογισμικού Ubuntu

• Με τα πλήκτρα Ctrl+Alt+T ανοίγουμε το τερματικό και γράφουμε την
εντολή

..
sudo apt-get install virtualbox

Αφού γράψουμε τον κωδικό του root, αρχίζει η εγκατάσταση. Μόλις εγκα-
τασταθεί, το “ανοιγουμε”.

Πατάμε “Νέα” και μας καλωσορίζει ο οδηγός εικονικής μηχανής

Δίνουμε όνομα στην εικονική μηχανή

Στη συνέχεια επιλέγουμε την ποσότητα της μνήμης της εικονικής μηχανής
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Επιλέγουμε το μέγεθος του εικονικού δίσκου

Επιλέγουμε τον τύπο αρχείου του εικονικού σκληρού δίσκου που είναι vdi

Για να λειτουργήσει σωστά το FreeDOS θα πρέπει να δώσουμε για το μέγε-
θος του εικονικού δίσκου την επιλογή “Δυναμική” (Dynamically allocated)

Στη συνέχεια δίνουμε όνομα στον εικονικό δίσκο. Προτεινόμενη επιλογή εί-
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ναι το ίδιο όνομα με την εικονική μηχανή που έχουμε δημιουργήσει

Αποθηκεύουμε τις ρυθμίσεις που έχουμε κάνει και πατάμε το κουμπί “Δη-
μιουργία” (Create).

Αν όλα έχουν πάει καλά θα δούμε μια εικόνα σαν την παρακάτω:

Το FreeDOS έχει μπει στην λίστα των εικονικών μηχανών της εφαρμογής
που τρέχουμε.

Πηγές

1. http://www.freedos.org/

2. http://sourceforge.net/apps/mediawiki/freedos/index.php?title=
VirtualBox
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Συνέντευξη με τον Δημήτρη Ντούλα του Γιώργου Μακρή

Στο τεύχος αυτό σκέφτηκα να πάρωμια συνέντευξη από κάποιον γνωστό

αλλά και συγχρόνως άγνωστο, έναν όχι μόνο χρήστη Linux και Ubuntu αλλά

τον έναν από τους διαχειριστές της ιστοσελίδας μας, τον φίλο “the_eye”. Ο

the_eye είναι και αυτός υπεύθυνος για τη σωστή λειτουργία της ιστοσελί-

δας μας, όχι μόνο στο επίπεδο του φόρουμ, αλλά και ό,τι παίζει ΠΙΣΩ από

αυτό που εμείς βλέπουμε.

-Γειά σου the_eye.

Είμαι ο Γιώργος και θα ήθελα για λίγο να αφήσουμε υπολογιστές, πλη-

κτρολόγια, ιστοσελίδες και να μας μιλήσεις λίγο για σένα.

Ξεκινώ με μία κλασσική ερώτηση:

Ποιο είναι το όνομά σου και πόσων χρόνων είσαι;

-Γεια σου Γιώργο, πραγματικά είναι μεγάλη έκπληξη για μένα, είμαι ο

Δημήτρης Ντούλας και είμαι 34 χρονών.

-Πού μένεις Δημήτρη;

-Μένω στην πόλη της Κοζάνης.

-Τι σπουδές έχεις κάνει;

-Έχω δίπλωμα ΙΕΚ Τεχνικού Η/Υ και δικτύων και φοιτώ στο Ελληνικό

Ανοιχτό Πανεπιστήμιο, στο τμήμα Πληροφορικής.

-Πώς μπήκες στο Linux και πότε;

-Η πρώτη επαφή με τον κόσμο του Linux ήταν το 2003 όταν προσπα-

θούσαμε να στήσουμε ένα ελεύθερο μητροπολιτικό wifi δίκτυο. Εκεί

χρειαζόμασταν servers, routers και ειδικές εγκαταστάσεις υπολογιστών

σε ταράτσες και άλλα. Πράγματα που κοστίζουν αρκετά λεφτά αν τα

αγοράσεις ως hardware. Γνωρίζοντας, όμως, για το Linux από έναν καθη-

γητή στο IEK άρχισα να το ψάχνω για να δω τι μπορώ να κάνω. Σύντομα

ανακάλυψα ότι ο μόνος περιορισμός που έχει το Linux είναι στην πραγμα-

τικότητα οι γνώσεις σου σε αυτό. Οπότε έπεσα με τα μούτρα. Έμαθα να

στήνω server, router, ένας ολόκληρος κόσμος γνώσης άνοιξε μπροστά μου.

-Πόσεςώρες ασχολείσαι με τη διαχείριση της σελίδας και πόσο δύσκολο

και απαιτητικό είναι;

-Παρακολουθώ το forum καθημερινάως χρήστης, για να γράψωαπαντή-

σεις σε ερωτήματα. Ως διαχειριστής, δηλαδή συντηρητής, δεν έχει πολλή

δουλειά πλέον. Τα περισσότερα προβλήματα έχουν επιλυθεί αλλά συνεχώς

υπάρχουν περιθώρια βελτίωσης.

Στο forum δεν συμμετείχα από την αρχή, το ανέλαβα κάποια στιγμή και

πιστεύω έβαλα και εγώ ένα λιθαράκι.

Η διαχείριση και ο συντονισμός του forum είναι αρκετά δύσκολος γιατί

ερχόμαστε μαζί με τους συντονιστές καθημερινά με αρκετά προβλήματα

διαφορετικήςφύσεως.Απόθέματαπουανοίγουνσελάθοςκατηγορίαμέχρι

μη αποδεκτό περιεχόμενο, είμαστε αρκετά καλή ομάδα και πιστεύω αυτό

βγαίνει και προς τα έξω.

Πρέπει το forum να είναι πάντα τακτοποιημένο, έτσι ώστε να μπορεί ένας

νέος χρήστης να διαβάζει περιεχόμενο τακτοποιημένο και συγκεντρωμένο.
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Διαφορετικά θα ήταν χαοτικό και απαξιωμένο.

-Ποια πρέπει να είναι τα βήματα που πιστεύεις ότι πρέπει να γίνουν για
τη μεγαλύτερη διάδοση αλλά και προβολή του Linux;
-Πιστεύω ότι πρέπει να προβληθεί περισσότερο σε ΜΜΕ. Πολλές ενημε-

ρωτικές εκπομπές θα μπορούσαν να φιλοξενήσουν 15 λεπτά για μια εισα-
γωγή στο ΕΛ/ΛΑΚ.
Πρέπει να γίνει γνωστό ότι υπάρχει επιλογή στο λειτουργικό του Η/Υ και

μετά ο κόσμος θα διαλέξει.

-Unity, Ubuntu, Mark Shuttleworth· τι σκέψεις σου έρχονται διαβάζο-
ντας αυτές τις λέξεις;
-Καινοτομία, στόχοι, όραμα και όχι απαραίτητα με αυτή την σειρά.

Χαίρομαι όταν ακούω από χρήστες υπολογιστών που είχαν για χρόνια
Windows να λένε ότι βρίσκουν το Ubuntu πιο απλό στην χρήση. Είναι
μεγάλο επίτευγμα κάτι τέτοιο.

-Μια ερώτηση που δημιουργεί στην κοινότητα πολλές και διαφορετικές
απόψεις: Ubuntu Mint - μαθητής καλύτερος από δάσκαλο;
-Δεν υπάρχει καλό ή κακό στο Linux. Οι διανομές είναι συγκοινωνούντα

δοχεία. Τα πακέτα που μοιράζονται είναι κοινά. Από εκεί και πέρα τα
υπόλοιπα είναι υποκειμενικά.

-Τι πιστεύεις; Βοηθούν ή κάνουν κακό τόσα Ubuntu παράγωγα;
-Φυσικά και δεν είναι κακό. Είναι ίσως και μια επιτυχία του Linux να

μπορέσει να καλύψει με αυτό τον τρόπο τις διαφορετικές προτιμήσεις του
καθενός.

-Πες μας λίγα λόγια για το http://klug.gr που είσαι και πρόεδρος. Πόσα
μέλη έχει, πόσο δύσκολο είναι στη χώρα μας η λειτουργία και η αυτο-
χρηματοδότηση μιας τέτοιας λέσχης;
-H Λέσχη Φίλων Ανοιχτού Λογισμικού Κοζάνης είναι μια προσπάθεια για

να γνωριστούμε με άλλα άτομα που μοιραζόμαστε το κοινό πάθος για το
ανοιχτό λογισμικό. Είμαστε μια καλή παρέα που από απλοί γνωστοί έχουμε
γίνει πλέον φίλοι. Άλλες φορές περισσότεροι, άλλες φορές λιγότεροι βγαί-
νουμε για καφέ, ποτό και πολλή κουβέντα.
Οι δραστηριότητες της λέσχης και τα έξοδα καλύπτονται από τα μέλη

της. Αυτό στις μέρες μας είναι αρκετά δύσκολο και για το λόγο αυτό έχουμε

αποφασίσει την παύση της ετήσιας συνδρομής. Δεν θέλουμε να επιβαρύ-
νουμε τα μέλη μας.

-Θα ήθελα κλείνοντας αυτή την συνέντευξη να σε ρωτήσω:
Τι είναι πιο δύσκολο, να είσαι διαχειριστής ιστοσελίδας ή νέος πατέρας
χαζομπαμπάς;
-Χα χα, το να είσαι χαζομπαμπάς δεν είναι δύσκολο, είναι απόλαυση. Ο μι-

κρούλης είναι σκέτη απόλαυση, κάθε μέρα κάτι καινούριο θα κάνει. Πρέπει
γενικά να γευόμαστε και να ζούμε τις στιγμές. Μικρά ή μεγάλα πράγματα
που μας κάνουν χαρούμενους.
Προσπαθώ να κρατήσω χαριτωμένες αναμνήσεις του μικρού στο μυαλό

μου για πάντα. 

-Δημήτρη ευχαριστούμε πολύ για αυτήν τη γνωριμία που είχαμε μέσω
αυτής της συνέντευξης.
-Ευχαριστώ και εγώ Γιώργο, καλή συνέχεια στον ubuntista μα και στην

προσπάθεια που κάνετε όλοι για το περιοδικό μας.
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Scribus (Μέρος 2ο) του Μάριου Παπαχρήστου

Πρόλογος

Γεια σας φίλες & φίλοι του Ubuntistas! Το άρθρο αυτό αποτελεί το δεύ-

τερο μέρος του οδηγού για το Scribus (για όσους δεν γνωρίζουν περί του

οδηγού, ας ανατρέξουν στο Τεύχος #14 και ας διαβάσουν την εισαγωγή στο

συγκεκριμένο πρόγραμμα). Στο συγκεκριμένο άρθρο θα ασχοληθούμε με

τουςοδηγούς (guides), οι οποίοι παίζουν καθεδρικόρόλοστηνδιαρρύθμιση

του εγγράφου μας, τις στρώσεις (layers), τα στυλ παραγράφου (paragraph

styles) και τις πρωτότυπες / κύριες σελίδες (master pages). Καλή μας συνέ-

χεια λοιπόν!

Οδηγοί (Guides)

Όλα τα έργα μας πρέπει να ακολουθούν κάποιους στοιχειώδεις κανόνες

που αφορούν την διάταξη των αντικειμένων (objects) μέσα στη σελίδα. Η

λέξη που περιγράφει στο έπακρο την προηγούμενη πρόταση είναι η λέξη

“διαστρωμάτωση”. Συνεπώς, προτιμότερο θα είναι στα έγγραφά μας να

χρησιμοποιούμε τους οδηγούς (guides), τα περιθώρια (margins), όπως και

το πλέγμα (grid). Πιο αναλυτικά:

• Για να ενεργοποιήσουμε το πλέγμα (δηλ. να είμαστε σε θέση να το

διακρίνουμε στην οθόνη μας) επιλέγουμε Προβολή→ Εμφάνιση Πλέγ-

ματος (View → Show Grid). Αν τυχόν θελήσουμε να ενεργοποιήσουμε

στοίχιση στο πλέγμα (δηλ. τα αντικείμενα να “αγκιστρώνονται” πάνω

στο πλέγμα), επιλέγουμε Σελίδα → Προσαρμογή στο Πλέγμα (Page →
Snap to Grid). Για παράδειγμα:

Εικόνα 1: Αντικείμενο στοιχισμένο στο πλέγμα

• Αν παρατηρήσατε, στη σελίδα σας εμφανίζονται τα περιθώρια του εγ-

γράφου (document margins). Αν θέλετε να εφαρμόσετε στοίχιση σε

αυτά, επιλέξτε Σελίδα → Προσαρμογή στους Οδηγούς (Page → Snap

to Guides). Αν και αυτή η ρύθμιση χρησιμεύει περαιτέρω (θα το δούμε

αμέσως μετά), εφαρμόζει εξίσου στοίχιση στα περιθώρια. Για παρά-

δειγμα:
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Εικόνα 2: Αντικείμενο στοιχισμένο στα περιθώρια της σελίδας

• Τέλος, χρησιμότεροι και βασικότεροι: οι οδηγοί! Ένα επιτυχημένο
layout οφείλει την ύπαρξή του σε αυτούς! Αρχίζοντας, ας παρατηρή-
σουμε μια σελίδα με οδηγούς:

Εικόνα 3: Οδηγοί

Όπως παρατηρήσατε, οι οδηγοί μας επιτρέπουν να στοιχίζουμε αντικεί-
μενα μέσα στο χώρο. Ρόλους οδηγών, εκτός αυτού, παίζουν και το πλέγμα
και τα περιθώρια.

Ξεκινάμε επιλέγοντας Σελίδα → Διαχείριση Οδηγών (Page → Manage
Guides). Θα αντικρίσουμε ένα παράθυρο το οποίο θα μας επιτρέπει να χει-
ριζόμαστε τους οδηγούς δια μέσου του. Στην πρώτη καρτέλα (tab) του πα-
ραθύρου μπορούμε να θέσουμε χειροκίνητα οδηγούς σε διάφορα σημεία
της σελίδας, ανάλογα με το πού θέλουμε (οριζόντια – κατακόρυφα).

Εικόνα 4: Χειροκίνητοι Οδηγοί

Επιπλέον, το Scribus μας δίνει την δυνατότητα να θέσουμε οδηγούς αυτό-
ματα (δηλ. στήλες) στη δεύτερη καρτέλα επιλογής, όπου μπορούμε να θέ-
σουμε οδηγούς τους οποίους το Scribus ορίζει αυτόματα.
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Εικόνα 5: Οδηγοί με στήλες

Τέλος, στην τρίτη καρτέλα μπορούμε να διαγράψουμε όλους τους οδη-
γούς.

Στυλ Παραγράφου (Paragraph Styles)

Το Scribus επιτρέπει να αποθηκεύσουμε συγκεκριμένες μορφοποιήσεις
στακείμενάμας, ταοποίαβρίσκονται μέσασταπλαίσια κειμένων, έτσιώστε
να μην ανατρέχουμε για να εφαρμόσουμε αυτές τις μορφοποιήσεις συνε-
χώς. Αυτήν την ευκολία μας την προσφέρουν τα “Στυλ Παραγράφου”. Για
να έχουμε πρόσβαση εκεί, επιλέγουμε Επεξεργασία→ Στυλ (Edit→ Styles).
Θα ανοίξει ένα παράθυρο στο οποίο μπορούμε να δημιουργήσουμε στυλ,
να διαγράψουμε στυλ, να αντιγράψουμε (κλωνοποιήσουμε) στυλ και να ει-
σάγουμε στυλ από άλλα έγγραφα.

Εικόνα 6: Διαχείριση Στυλ

Στρώσεις (ή Στρώματα) (Layers)

Όσοι έχουν ασχοληθεί με προγράμματα επεξεργασίας εικόνας θα γνωρί-
ζουν προσεγγιστικά την έννοια των στρώσεων (layers). Για όσους δεν γνω-
ρίζουν, στις στρώσεις τοποθετούμε αντικείμενα τα οποία μεν βρίσκονται
στον ίδιο χώρο, όμως δεν μπορούν να αλληλεπιδράσουν αν δεν βρίσκο-
νται στην ίδια στρώση. Πλεονέκτημα τωνστρώσεων είναι ότι μπορεί κανείς
να αποκρύψει ή να εμφανίσει στρώσεις, επιτυγχάνοντας έτσι διαφορετικό
αποτέλεσμα κάθε φορά, χωρίς όμως να μεταφέρει τα επιλεγμένα αντικεί-
μενασεάλλο έγγραφο.Π.χ. θέλουμε να τυπώσουμε ένα έγγραφομε εικόνες
και το ίδιο έγγραφο χωρίς αυτές. Ξεκινάμε επιλέγοντας Παράθυρο→ Στρώ-
ματα (Window→ Layers). Θα λάβουμε μια εικόνα σαν κι αυτή:
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Εικόνα 7: Παράθυρο στρώσεων

Μπορούμε να δημιουργήσουμε στρώσεις πατώντας το κουμπί “Προ-
σθήκη” (+), να διαγράψουμε πατώντας το κουμπί “Αφαίρεση” (-), να αντι-
γράψουμε στρώσεις, να ανεβάσουμε στρώσεις κατά ένα επίπεδο (κουμπί
μεάνωβέλος), καθώςκαι νακατεβάσουμεστρώσεις κατάέναεπίπεδο (κου-
μπί με κάτω βέλος).
Όσον αφορά, βέβαια, μεμονωμένα τις ιδιότητες των στρώσεων (στρω-

μάτων), αυτές έχουν ως εξής (αριστερά→ δεξιά):

Εικόνα 8: Σειρά Στρώσεων

1. Κάντε το στρώμα / τη στρώση ορατό/ή (Make layer visible)

2. Κάντε το στρώμα εκτυπώσιμο (Print layer)

3. Κλειδώστε ή ξεκλειδώστε το στρώμα (Lock or unlock the layer)

4. Κάντε το κείμενο των κατώτερωνστρώσεων να ρέει γύρωαπό τα αντι-
κείμενα (Make text of lower layers flow around objects)

5. Προβάλετε μόνο το περίγραμμα των αντικειμένων που βρίσκονται
στην συγκεκριμένη στρώση (Outline mode).

6. Τέλος, δίπλα εμφανίζεται το όνομα της στρώσης

Συμπεραίνουμε, ότι τα layers βοηθούν κατά πολύ στο να κάνουν ένα έγ-
γραφο πιο ξεκάθαρο και εύχρηστο. Προσωπικά, κατά τη σελιδοποίηση του
Ubuntistas χρησιμοποίησα τα εξής στρώματα:

1. Background Layer→ Έμενε κενό για τυπικούς λόγους

2. Κυρίως Κείμενο→ Αποτελούταν από τα πλαίσια κειμένου του περιοδι-
κού, δηλ. περιείχε τα κείμενα των άρθρων

3. Πλαίσια Κώδικα→ Αποτελούνταν από απλά πλαίσια τα οποία τοποθε-
τούνταν πάνω από τα σημεία στα οποία ήταν γραμμένος κώδικας π.χ.

..
sudo su

4. Εικόνες→Όπου είχαν τοποθετηθεί οι εικόνες του τεύχους

5. Υπερσύνδεσμοι (Hyperlinks)→Όπουείχαν τοποθετηθεί ταπλαίσιαπου
παρέπεμπαν σε links

Πρωτότυπες Σελίδες (Master Pages)

Οισελίδεςαυτέςουσιαστικάμαςβοηθούνστοότι δεν έχουμε ναδημιουρ-
γούμε συνεχώς την ίδια σελίδα σε ένα έγγραφο αλλά μπορούμε να την
εφαρμόζουμε όποτε θέλουμε. Για παράδειγμα, στο Ubuntistas τα σημεία
που καθορίζουν σε ποια ενότητα βρίσκεται ο αναγνώστης (πάνω μέρος της
σελίδας) ανήκουνσε μιαmasterpage. Ξεκινάμε επιλέγοντας Επεξεργασία→
Πρωτότυπες Σελίδες (Edit→Master Pages), όπουθαβρεθούμε μπροστάσε
ένα τέτοιο παράθυρο:
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Εικόνα 9: Παράθυρο Πρωτότυπων Σελίδων

Με τα κουμπιά μπορούμε να εκτελέσουμε τις εξής λειτουργίες:

1. Προσθήκη πρωτότυπης σελίδας (Add master page)

2. Αντίγραφο επιλεγμένης πρωτότυπης σελίδας (Duplicate selected
maste page)

3. Εισαγωγή πρωτότυπης σελίδας από άλλο έγγραφο (Insertmaster page
from another document)

4. Διαγραφή επιλεγμένης πρωτότυπης σελίδας (Delete selected master
page)

Εξαρχής, το Scribus έχει μια κενή πρωτότυπη σελίδα που είναι εφαρμο-
σμένη σε όλες τις σελίδες του εγγράφου μας.
Μπορούμε να κάνουμε χρήση των πρωτότυπων σελίδων που δημιουργή-

σαμε από το μενού Σελίδα:

• Σελίδα→ Εφαρμογή πρωτότυπης σελίδας

• Σελίδα→Μετατροπή σε πρωτότυπη σελίδα

Επίλογος

Τώρα που αποκτήσατε επιπλέον γνώσεις πάνωστον χειρισμό του Scribus
μπορείτε να πειραματιστείτε ελεύθερα με τις λειτουργίες του. Καλή ενασχό-
ληση, λοιπόν!

Πηγές

1. Full Circle Magazine – Scribus Special Issue
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X11 Basic:
Μια απλή BASIC βασισμένη στην GFA BASIC του Atari ST του Χρήστου Τζιώτζη

Μετά από μια συζήτηση στο φόρουμ της κοινότητας αποφάσισα να

γράψω το πρώτο μου άρθρο για το περιοδικό, μια παρουσίαση της γλώσ-

σας X-11 BASIC, μιας διαλέκτου της BASIC που βασίζεται στην παλιά καλή

GFABASIC.Ηαλήθεια είναι ότι σκέφτηκαπολύ για τοπώς ναγράψωαυτό το

άρθρο, δεν είχα παρουσιάσει ποτέ πριν μια γλώσσα προγραμματισμού. Οι

δύο επιλογές μου ήταν να κάνω μια περίληψη των 466 σελίδων τουmanual

ή να δείξω ένααπλό πρόγραμμα και το αποτέλεσμα του. Κατέληξα να δώσω

λιγότερη βάση στο πρώτο και περισσότερη στο δεύτερο...

Το πρώτο πράγμα που πρέπει να γίνει είναι η εγκατάσταση της γλώσσας,

η οποία έρχεται σε ένα πακέτο deb για τους χρήστες Ubuntu. Περιλαμβά-

νει τον interpreter, το virtual machine, και τον compiler. Το παράξενο με την

X11-BASIC είναι ότι ο compiler δεν κάνει ακριβώς μεταγλώττιση, αλλά με-

τατροπή σε bytecode, ο οποίος τρέχει στο vm. Εναλλακτικά, ο compiler με-

τατρέπει τον κώδικασεC και μετά μεταγλωττίζει τον κώδικαC. Αυτόβέβαια

λίγο ενδιαφέρει τον χρήστη.

Η X-11 BASIC είναι μια δομημένη γλώσσα προγραμματισμού και μπορώ

να την περιγράψω σαν μια μίξη της BASIC με την PASCAL. Έτσι, περιλαμ-

βάνει όλα όσα θα περίμενε κανείς, βρόχους, υπορουτίνες, συναρτήσεις. Σε

ό,τι αφορά τις μεταβλητές και τους πίνακες, η X11 BASIC αναγνωρίζει τρεις

τύπους, integer, float και string. Συγκεκριμένα:

• η μεταβλητή x=193.45 είναι πραγματικός αριθμός 64-bit

• η μεταβλητή x%=24 ακέραιος 32-bit

Εικόνα 1: Ένα παράδειγμα για gui από την xbasic
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• και η μεταβλητή x$=”Καλησπέρα” αλφαριθμητικό

Αντίστοιχα πράγματα ισχύουν και για τους πίνακες. Τα σύμβολα %, $ δη-

λώνουν το είδος της μεταβλητής, κατ’ αντιστοιχία με τις δηλώσεις “int x;”

και “char x;” της C. Οι μεταβλητές x και x% όμως είναι διαφορετικές, και

έτσι μπορούν να χρησιμοποιούνται ταυτόχρονα στο πρόγραμμα. Οι μετα-

βλητές δηλώνονται οπουδήποτε στο πρόγραμμα, χωρίς λέξη-κλειδί, αλλά

υπάρχει διαχωρισμός μεταξύ global και local μεταβλητών, με τις δεύτερες

να δηλώνονται μέσα στην συνάρτηση ή την υπορουτίνα.

Οι υπορουτίνες δηλώνονται με τη λέξη-κλειδί PROCEDURE, το όνομα

τους και τις παραμέτρους που παίρνουν, ενώ κλείνουν με τη λέξη RETURN.

Οι τοπικές μεταβλητές δηλώνονται με τη λέξη LOCAL. Οι υπορουτίνες κα-

λούνται με τη λέξηGOSUBή τοσύμβολο@. Σε αντίθεσημε τις συναρτήσεις,

οι υπορουτίνες δεν επιστρέφουν τιμή. Αντίστοιχα, οι συναρτήσεις δηλώνο-

νται με τη λέξη FUNCTION, επιστρέφουν τιμή με RETURN value και κλεί-

νουν με τη λέξη ENDFUNCTION.

H x11-BASIC έχει τέσσερα είδη βρόχων: o FOR –NEXT εκτελεί τον βρόχο

μέχρι ναφτάσουμε στην προεπιλεγμένη τιμή· οWHILE –WEND ελέγχει τον

όρο στην αρχή· ο REPEAT – UNTIL ελέγχει τον όρο στο τέλος· τέλος, ο DO

– LOOP είναι ένας ατέρμονας βρόχος. Οι εντολές ελέγχου είναι οι IF – ELSE

-ENDIF.

Όπως θα περίμενε κανείς, η X11-BASIC διαθέτει επίσης αριθμητικούς και

λογικούς τελεστές και έναπλήρες σετ εντολών. Ας δούμε λοιπόνστην πράξη

τι μπορούμε να κάνουμε με αυτήν την διάλεκτο.

Το παρακάτω πρόγραμμα είναι μια προσομοίωση του φαινόμενου

Diffusion Limited Aggregation – DLA, ελληνιστί Συσσωμάτωση περιορι-

σμένη από την διάχυση. Ουσιαστικά το DLA είναι ένα fractal, το οποίο συ-

ναντάμε στην φυσική υλικών και όχι μόνο, και το οποίο έχει περίεργες ιδιό-

τητες. Το πρόγραμμα το είχα γράψει αρχικά σε GFA – BASIC σε έναν Atari

Falcon 030. Η μετατροπή ήταν πολύ εύκολη (αν και χρειάστηκα την βοή-

θεια του προγραμματιστή της γλώσσας για να αφαιρέσω κάποια σύμβολα

τα οποία έχουν καταργηθεί (σημείωση προς εμένα: RTFM).

Εικόνα 2: Fractal για 2500 σωματίδια

..

CLS

PRINT ”How many particles do you want? ”

input particles

Εδώ έχουμε την πρώτη εισαγωγή μεταβλητής, τον αριθμό των σωματι-

δίων πουθέλουμε να κολλήσουν. Κανονικά θα έπρεπε να ήταν integer, αλλά

μιας και η RAM δεν είναι πρόβλημα όπως στον ST, το αφήνουμε...

..

CLEARW

yellow=GET_COLOR(65535,65535,0)

blue=GET_COLOR(0,0,65535)

DIM screen%(640,400)

th=90

’ Fill array screen with inigfabastial values

color get_color(65535,32000,0)

screen%(320,200)=1

color=blue
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..

plot x,y

vsync

counter=1

tttt=timer

@feed gfabas

@fractal

@saving

print timer-tttt;” Seconds.”

quit

Σε αυτό το κομμάτι του κώδικα βλέπουμε όλο το πρόγραμμα. Ορίζουμε

έναν πίνακα διαστάσεων 640x400, στον οποίο θα εξελιχθεί το φαινόμενο.

Ορίζουμε επίσης το σωματίδιο στο κέντρο, πάνω στο οποίο θα προσκολ-

ληθούν όλα τα υπόλοιπα. Σχεδιάζουμε αυτό το σωματίδιο με την εντολή

plot x,y, όπου κάθε pixel αντιστοιχεί και σε ένα σωματίδιο. Ταυτόχρονα,

(και αυτό είναι ένα ακόμη χαρακτηριστικό της X11-BASIC) ανοίγει και το πα-

ράθυρο στο οποίο θα σχεδιάζονται τα γραφικά. Αυτό είναι μια βελτίωση σε

σχέση με την GFA BASIC, στην οποία δεν είναι και τόσο απλό αυτό το βήμα.

Μετά, βλέπουμε ότι καλούνται τρεις υπορουτίνες. Ας δούμε τι κάνουν...

1. feed

H feed τοποθετεί το σωματίδιο σε ακτίνα r από το κέντρο. Η ακτίνα

αυτή πρέπει να μεγαλώνει όσο μεγαλώνει και το fractal.

..

PROCEDURE feed

’ place a particle in a random position on the

periphery of a circle

’ of radius r

fi=RANDOM(360)

r=15+radd%

x=INT(320+r*COS(fi))

y=INT(200+r*SIN(fi))

IF screen%(x,y)=1

GOSUB feed

ENDIF

..

’Check if the feed particle falls near an occupied place.

It shouldn’t happen but better safe than sorry.

IF screen%(x-1,y-1)=1 OR screen%(x-1,y)=1 OR screen%(x

-1,y+1)=1 OR screen%(x,y-1)=1 OR screen%(x,y+1)=1

OR screen%(x+1,y-1)=1 OR screen%(x+1,y)=1 OR screen

%(x+1,y+1)=1

screen%(x,y)=1

GOSUB feed

ENDIF

RETURN

Οι τιμές της γεννήτριας τυχαίων αριθμώνμετατρέπονται σε ακέραιους,

γιατί οι συντεταγμένες δεν μπορεί να είναι δεκαδικοί αριθμοί. Θεωρη-

τικά, οι μεταβλητέςθαέπρεπε ναείχανοριστείωςακέραιοι, αλλά, όπως

είπαμε, η μνήμη δεν είναι πρόβλημα. Ταυτόχρονα, σε αυτό το κομμάτι

συναντάμε και τους πρώτους ελέγχους για το αν το σωματίδιο αφήνε-

ται σε κατειλημμένη θέση ή αν προσκολλάται αμέσως, κάτι που θα χα-

λούσε την προσομοίωση. Αυτό μπορεί να συμβεί μόνο στην περίπτωση

που το φράκταλ αυξάνεται ταχύτερα από την ακτίνα. Οι έλεγχοι γίνο-

νται με IF και τον τελεστή OR για καθεμιά από τις 8 πιθανές θέσεις.

2. fractal

Εδώ είναι και το σημαντικότερο τμήμα του κώδικα. Η υλοποίηση του

αλγόριθμου της DLA. Το σωματίδιο αρχίζει να κινείται με τυχαίο τρόπο,

πρώτα στον άξονα x και μετά στον άξονα y. Σε κάθε βήμα ελέγχεται

κάθε γειτονική θέση στον πίνακα. Αν αυτή δεν είναι κατειλημμένη, τότε

το σωματίδιο συνεχίζει την κίνηση του. Αν είναι, προσκολλάται.

..

PROCEDURE fractal

’ This is the DLA algorithm. Particle follows brownian

motion. In each step

’ a check is being performed for the existance of a

neigbouring particle.

’ If such a particle exists then the particle sticks

and a new one is being
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..

’ released

DO

n%=RANDOM(3)-1

x=x+n%

IF x<320-2*r

x=(320-r)

ENDIF

IF x>320+2*r

x=320+r

ENDIF

IF screen%(x,y)=1

GOSUB fractal

ENDIF

’Checking for neighbouring particle after motion on the x

-axis

IF screen%(x-1,y-1)=1 OR screen%(x-1,y)=1 OR screen%(

x-1,y+1)=1 OR screen%(x,y-1)=1 OR screen%(x,y+1)

=1 OR screen%(x+1,y-1)=1 OR screen%(x+1,y)=1 OR

screen%(x+1,y+1)=1

screen%(x,y)=1

color yellow

PLOT x,y

vsync

insert=1

IF insert=1

inc counter

GOSUB feed

ENDIF

ENDIF

m%=RANDOM(3)-1

y=y+m%

IF y<200-1.5*r

..

y=200-r

ENDIF

IF y>200+1.5*r

y=200+r

ENDIF

’Checking for neighbouring particle after motion on the y

-axis

IF screen%(x-1,y-1)=1 OR screen%(x-1,y)=1 OR screen%(x

-1,y+1)=1 OR screen%(x,y-1)=1 OR screen%(x,y+1)=1

OR screen%(x+1,y-1)=1 OR screen%(x+1,y)=1 OR

screen%(x+1,y+1)=1

screen%(x,y)=1

color blue

PLOT x,y

vsync

insert=1

IF insert=1

counter=counter+1

ENDIF

ENDIF

’ PRINT AT(1,1);x,y,counter,r,particles

exit IF counter>particles

radd%=sqrt((x-320)^2+(y-200)^2)

LOOP

RETURN

Όλος ο αλγόριθμος περιλαμβάνεται σε έναν βρόχο DO – LOOP, ο

οποίος, όπως είπαμε, είναι ένας ατέρμονας βρόχος. Αυτό όμως είναι

ένα μικρό ψέμα. Υπάρχουν στην πραγματικότητα 2 διαφυγές από το

βρόχο. Η πρώτη είναι όταν προσκολληθεί το σωματίδιο, οπότε η δια-

φυγή γίνεται με ένα GOSUB στην feed· η δεύτερη είναι όταν έχει συ-

μπληρωθεί ο αριθμός των σωματιδίων, οπότε ένα EXIT IF μας πηγαί-

νει στο κυρίως πρόγραμμα. Το άλλο που μπορούμε να παρατηρήσουμε

είναι ότι το σωματίδιο είναι χρώματος μπλε όταν προσκολλάται με κί-

νηση στον άξονα των y και κίτρινο όταν προσκολλάται με κίνηση στον

άξονα των x. Αν ο αλγόριθμος μας είναι σωστός, τότε τα μπλε και κί-
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τρινα σωματίδια θα πρέπει να είναι περίπου ίσα...

Εικόνα 3: fractal για 3500 σωματίδια

3. saving

Η saving σώζει το παράθυρο σε μορφή bmp.

Η εκτέλεση του προγράμματος μπορεί να γίνει με τρεις τρόπους: από

τον interpreter, το virtual machine ή από το εκτελέσιμο μέσω C. Η τε-

λευταία μέθοδος δεν δούλεψε για μένα, λογικά λόγω64-bit. Τοσφάλμα

ήταν μη συμβατές βιβλιοθήκες. Παλιότερα, σε 32-bit επεξεργαστή, δεν

είχα πρόβλημα.

Εν κατακλείδι:

Η X11-BASIC είναι μια πραγματικά καλή γλώσσα προγραμματισμού, τόσο

για εκμάθηση, όσο και για όσους θέλουν πραγματικά να αναπτύξουν εφαρ-

μογές κονσόλας ή ενός υποτυπώδους γραφικού περιβάλλοντος. Η Χ11-

BASIC έχει δυνατότητες για GUI το οποίο θυμίζει πάρα πολύ αυτό του ATARI

ST, για την ακρίβεια είναι συμβατό, αλλά δεν είναι σε καμιά περίπτωση στο

ίδιο επίπεδο με αυτό της QT ή της GTK. Αν κάποιος έχει εμπειρία με το GEM,

τότε θα του φανεί πολύ οικείο. Σίγουρα είναι λειτουργικό, απλά δεν είναι

τόσο όμορφο, ακόμα και σε σχέση με τις νεότερες εκδόσεις του TOS (του

λειτουργικού του Atari ST). Μια δεύτερη δυνατότητα είναι η ανάπτυξη cgi

script, αλλά δεν ξέρω αρκετά πάνω σε αυτό το θέμα για να το αναπτύξω

περισσότερο. Σίγουρα πάντως, μια εφαρμογή σαν αυτή που παρουσίασα

μπορεί να υλοποιηθεί αρκετά καλά με την X11-BASIC. Ένα τελευταίο μειονέ-

κτημα είναι η έλλειψη syntax highlighting για κάποιον editor όπως το gedit

ή το bluefish. Υπάρχει για τον nedit, αλλά δεν μπορώ να πω ότι μου άρεσε.

Εικόνα 4: Ένα παράδειγμα αναλογικού ρολογιού για κονσόλα

Η X11-BASIC διατίθεται υπό την GPL v2. Ο προγραμματιστής της είναι ο

Markus Hoffmann.

To dla.bas διατίθεται υπό την WTFPL v2.

http://x11-basic.sourceforge.net/
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Υ.Γ. 1. Θα είδατε ότι κάποιες λέξεις-κλειδιά ήταν με κεφαλαία και κάποιες με

μικρά. Αυτό συνέβη γιατί η GFA BASIC απαιτεί κεφαλαία, ενώ η X11 δεν έχει

τέτοια κολλήματα. Οπότε ότι δεν πειράχθηκε από τον Atari έμεινε σε κεφαλαία.

Υ.Γ. 2. Υπάρχει και ένα δεύτερο ψέμα στο DLA. Το κανονικό φράκταλ ελέγχει

μόνο τους 4 γείτονες, ενώ αυτό 8. Το σχήμα βγαίνει λιγάκι διαφορετικό έτσι.

Αλλά η μετατροπή σε κανονικό DLA αφήνεται ως άσκηση στον αναγνώστη (πά-

ντα ήθελα να το γράψω αυτό).
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Εισαγωγή στην Ruby on Rails του Γιάννη Κωστάρα

Σ’ αυτό το άρθρο θα μιλήσουμε για την ανάπτυξη εφαρμογών ιστού, ή

αλλιώς δυναμικών ιστοσελίδων. Σχεδόν κάθε γλώσσα προγραμματισμού

παρέχει και τη δυνατότητα δημιουργίας δυναμικών ιστοσελίδων:

• C→ CGI

• Perl→ PHP

• Java→ Java Enterprise Edition (JEE), Spring MVC κ.ά.

• .NET→ ASPX

• Groovy→ Grails

• Ruby→ Ruby on Rails (RoR)

• Python→ Django

• Erlang→ Erlang

Αν και η PHP αποτελεί την πιο διαδεδομένη γλώσσα ανάπτυξης εφαρμο-

γών ιστού, η Ruby on Rails (RoR) σας επιτρέπει την ανάπτυξη εφαρμογών

ιστού πολύ γρήγορα χάρις στις παραδοχές της και τη μοντέρνα σχεδίασή

της. Η φιλοσοφία της γλώσσας αποτελείται από τις ακόλουθες αρχές:

• “Μην επαναλαμβάνεσαι” - Don’t Repeat Yourself (DRY)

• “Σύμβαση αντί για ρύθμιση” - Convention over Configuration

• “REST” - οργάνωση της εφαρμογής γύρω από τους πόρους

Καθώς ο αναγνώστης έχει μια γνώση της γλώσσας Ruby από προηγούμενα

τεύχη, ήταν φυσικό επακόλουθο να επιλεγεί για να δούμε πώς μπορεί να τη

χρησιμοποιήσει για ν’ αναπτύξει εφαρμογές ιστού ή δυναμικές ιστοσελίδες.

Υπόβαθρο

Οι εφαρμογές ιστού ακολουθούν μια λίγο πιο πολύπλοκη αρχιτεκτονική

από τις εφαρμογές επιφάνειας εργασίας (desktop) ή αυτόνομες εφαρμο-

γές (standalone).Όπωςφαίνεται στοακόλουθοσχήμα, ακολουθούν την αρ-

χιτεκτονική MVC (Model-View-Controller) όπου η Προβολή (View) βρίσκε-

ται συνήθως στον Η/Υ του πελάτη (client) ενώ ο Ελεγκτής (Controller) και

το Μοντέλο (Model) στον διακομιστή (server) ή σε διαφορετικούς διακο-

μιστές. Η επικοινωνία με το χρήστη (Προβολή - View) γίνεται μέσω ενός

πλοηγού (π.χ. Firefox, Chrome κλπ.), δηλ. δεν απαιτούν περαιτέρω εγκα-

τάσταση άλλης εφαρμογής στον Η/Υ του χρήστη. Μια Βάση Δεδομένων

(π.χ. Sqlite, Postgresql, MySQL, Oracle κλπ.) αποθηκεύει τα δεδομένα (Μο-

ντέλο -Model) και τέλος ένας διακομιστής ιστού (web server) ή διακομιστής

εφαρμογών (application server) παίζει το ρόλο του ελεγκτή (controller), του

οποίου η δουλειά είναι να επεξεργάζεται τις αιτήσεις που προέρχονται από

τον πλοηγό ανακτώντας δεδομένα από τη ΒΔ και να επιστρέφει τις απαντή-

σεις σε μια μορφή που μπορεί να απεικονίσει ο πλοηγός (π.χ. HTML).
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Εικόνα 1: Αρχιτεκτονική μιας εφαρμογής ιστού

Παραδείγματα διακομιστών ιστού φαίνονται στον ακόλουθο πίνακα:

Γλώσσα Διακομιστής Ιστού

PHP Apache

JEE Apache Tomcat

Jetty

Oracle GlassFish

BEAWebLogic

IBMWebSphere

ASPX IIS

RoR Mongrel, Webrick

Grails (βλ. JEE)

Django Apache, Cherokee

Erlang Yaws
Πίνακας 1: Διακομιστές ιστού ανά γλώσσα προγραμματισμού

Τέλος, πριν προχωρήσουμε, αξίζει να εξηγήσουμε ποια είναι η διαφορά
μεταξύ της Ruby και της Ruby on Rails. Ενώ η πρώτη είναι μια γλώσσα προ-
γραμματισμού, την οποία γνωρίσαμε σε παλαιότερα τεύχη, η RoR δεν εί-
ναι τίποτα άλλο από αρχεία συνόδου (scripts) γραμμένα σε Ruby τα οποία
αποτελούν το πλαίσιο εργασίας (framework) για την ανάπτυξη εφαρμογών
ιστού.

Εγκατάσταση

Έχοντας εγκαταστήσει τη Ruby (αν όχι, ανατρέξτε στο τεύχος 6), μπορείτε
πολύ εύκολα να εγκαταστήσετε τη Ruby on Rails (RoR) ως εξής:

..

$ sudo gem update --system

$ sudo gem sources -a http://gemcutter.org

$ sudo gem install rails

$ rails –v

Rails 3.2.8

(Η Ruby 1.9.1 ενδέχεται να σας δημιουργήσει προβλήματα με τη RoR, γι’
αυτό είτε αναβαθμιστείτε στην 1.9.2 είτε χρησιμοποιήστε την 1.8.7). Η πιο
πάνω εντολή προ-απαιτεί την εγκατάσταση του πακέτου rubygems. Αν δεν
το έχετε εγκαταστήσει, εγκαταστήστε το προτού εκτελέσετε τις παραπάνω
εντολές:

..
$ sudo gem install rubygems

Τέλος, απαιτείται η εγκατάσταση του Συστήματος Διαχείρισης Βάσεων Δε-
δομένων (ΣΔΒΔ) Sqlite:

..

$ sudo apt-get install sqlite3 libsqlite3-dev

$ sudo gem install sqlite3

Απαιτήσεις συστήματος

Θα αναπτύξουμε μια εφαρμογή διαχείρισης έργων (tasks), δηλ. μια λίστα
todo. Ακολουθούν οι απαιτήσεις της εφαρμογής:

• Η εφαρμογή θα εμφανίζει μια λίστα έργων

• Ο χρήστης θα μπορεί να δημιουργήσει ένα νέο έργο, να ενημερώσει
ένα έργο ή να διαγράψει ένα ή περισσότερα έργα

• Τα έργα θα πρέπει να έχουν προτεραιότητες (0-100), ώστε οι χρήστες
να μπορούν να επικεντρώνονται στα έργα με τις υψηλότερες προτε-
ραιότητες
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• Τα έργα θα πρέπει να έχουν προθεσμίες, ώστε οι χρήστες να επικε-
ντρώνονται σε εκείνα τα έργα που λήγουν

• Θα πρέπει να υπάρχουν οπτικές ενδείξεις για έργα που έχει περάσει η
προθεσμία τους ή είναι έτοιμα να λήξουν

• Τα έργα μπορούν να μαρκαριστούν ότι έχουν ολοκληρωθεί, αλλά αυτό
δε σημαίνει ότι θα διαγραφούν ή δε θα εμφανίζονται εκτός κι αν ο χρή-
στης επιλέξει να τα διαγράψει.

Θα υπάρχουν δυο κύριες οθόνες για την εφαρμογή: μια λίστα έργων και
μια φόρμα εισαγωγής/ανάγνωσης έργων. Ένα σκίτσο φαίνεται στην εικόνα
2.

Εικόνα 2: Σκίτσα της εφαρμογής διαχείρισης έργων

Δημιουργία μιας πρότυπης εφαρμογής

Ας δημιουργήσουμε μια νέα εφαρμογή RoR:

..
$ rails new todo

Η εντολή αυτή θα δημιουργήσει μια νέα εφαρμογή RoR στον κατάλογο
todo. Αν όλα πήγαν καλά, κι αφού δώσατε τον κωδικό του συστήματος όταν
και αν σας ζητήθηκε, τότε θα πρέπει να δείτε το παρακάτω μήνυμα:

..

Your bundle is complete! Use ‘bundle show [gemname]‘ to see

where a bundled gem is installed.

Ηανωτέρω εντολή rails δημιούργησε μια πλήρη εφαρμογή ιστού. Για να την
εκτελέσετε, εκκινήστε πρώτα τον διακομιστή:

..

$ cd todo

$ rails server &

=> Booting WEBrick

=> Rails 3.2.8 application starting in development on http

://0.0.0.0:3000

=> Call with -d to detach

=> Ctrl-C to shutdown server

[2012-10-16 23:37:19] INFO WEBrick 1.3.1

[2012-10-16 23:37:19] INFO ruby 1.8.7 (2012-02-08) [

universal-darwin11.0]

[2012-10-16 23:37:19] INFO WEBrick::HTTPServer#start: pid

=9779 port=3000

Started GET ”/assets/rails.png” for 127.0.0.1 at Tue Oct 16

23:37:32 +0200 2012

Connecting to database specified by database.yml

Served asset /rails.png - 304 Not Modified (2ms)

Ανοίξτε τον αγαπημένο σας πλοηγό και πλοηγηθείτε στη διεύθυνση:
http://localhost:3000. Θα δείτε την αρχική σελίδα του διακομιστή. Η αρχική
αυτή σελίδα είναι η public/index.html. Αν η παραπάνω εντολή εκκίνη-
σης του server ’πέταξε’ κάποια εξαίρεσησχετικάμεexecjs, δώστε τηνακό-
λουθη εντολή και ξαναδοκιμάστε.

..
$ sudo gem install nodejs

Θα παρατηρήσετε ότι η εντολή rails δημιούργησε ένα σωρό από αρ-
χεία μέσα στον φάκελο todo. Η RoR ακολουθεί την αρχή της σύμβασης
(convention) έναντι της ρύθμισης (configuration), με απλά λόγια περιμένει
ότι θα ονομάσετε τα αρχεία σας σύμφωνα με κάποιους κανόνες σύμβασης
και θα τα τοποθετήσετε σε κάποιους προκαθορισμένους φακέλους. Έτσι,
δεν χρειάζεται να τροποποιήσετε κάποιο(-α) αρχείο(-α) ρυθμίσεων (όπως
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π.χ. το web.xml στην JEE).
Άμα ανατρέξουμε στις απαιτήσεις τις εφαρμογής, θα δούμε ότι χρειάζε-

ται να δημιουργήσουμε σελίδες για τη Δημιουργία (Creation), Ανάγνωση
(Read), Ενημέρωση (Update) και Διαγραφή (Delete) έργων (ΔΑΕΔ – CRUD).
Η ακόλουθη εντολή (scaffold) δημιουργεί μια πρότυπη εφαρμογή που κάνει
ακριβώς αυτά. Το μόνο που χρειάζεται να της περάσουμε είναι πληροφο-
ρίες για το μοντέλο μας, που δεν είναι άλλο από την κλάση Task:

..

$ rails generate scaffold Task description:string priority:

integer dueDate:date alert:boolean daysBefore:integer

details:text

Η κλάση Task περιλαμβάνει τα ακόλουθα πεδία:

Πεδίο Τύπος δεδομένων

description string

priority integer

dueDate date

alert boolean

daysBefore integer

details text
Πίνακας 2 – Πεδία κλάσης Task

Προτού όμως μπορέσουμε να δούμε μια λίστα έργων στον πλοηγό μας,
θα πρέπει να δημιουργήσουμε τη βάση δεδομένων (ΒΔ) που θα αποθηκεύ-
σει ταδεδομέναμας.Όπως ίσωςπροσέξατε, ηRoRχρησιμοποιεί εξ ορισμού
την Sqlite3 ως ΒΔ. Αυτό βέβαια μπορεί να αλλάξει εύκολα όπως θα δούμε
αργότερα, όταν θα αλλάξουμε την εφαρμογή μας ώστε να χρησιμοποιήσει
τη MySQL. Για την ώρα όμως, η Sqlite μας κάνει μια χαρά. Όταν τρέξαμε
την παραπάνω εντολή, η RoR δημιούργησε κι ένα μικρό script μετάβασης
(migration) το οποίο θα χρησιμοποιήσουμε για να δημιουργήσουμε τον
πίνακα που θ’ αποθηκεύσει τα δεδομένα μας. Αυτό βρίσκεται στο φάκελο
db/migrate:

..

class CreateTasks < ActiveRecord::Migration

def change

create_table :tasks do |t|

..

t.string :description

t.integer :priority

t.date :dueDate

t.boolean :alert

t.integer :daysBefore

t.text :details

t.timestamps

end

end

end

20121021092304_create_tasks.rb

Για να δημιουργήσετε τον πίνακα tasks (βλέπετε τη σύμβαση; αφού η
κλάσημας ονομάζεταιTask, ο πίνακας θαονομαστείtasks), εκτελέστε την
εντολή:

..

$ rake db:migrate

== CreateTasks: migrating

====================================================

-- create_table(:tasks)

-> 0.0020s

== CreateTasks: migrated (0.0026s)

===========================================

Η εντολή rake είναι κάτι αντίστοιχο με την εντολή make για τη C και την
ant για τη Java.

Για να δούμε αν τα καταφέραμε. Αν ακόμα τρέχετε τον διακομιστή, τότε
πλοηγηθείτε στην ιστοσελίδα: http://localhost:3000/tasks

Listing Tasks
Description Priority Duedate Alert Daysbefore Details
New Task

Μην κάθεστε! Προσθέστε μερικά έργα (βλ. Εικόνα 3):
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Εικόνα 3: Δημιουργία νέου έργου

Θαδείτε ότι έχετε δημιουργήσει μια σχεδόν πλήρη εφαρμογή ιστού όπου
μπορείτε να δημιουργήσετε, ενημερώσετε, διαγράψετε έργα καθώς και να
δείτε μια λίστα των διαθέσιμων έργων.
Η λίστα έργων θα φαινόταν πιο επαγγελματική αν οι κεφαλίδες των στη-

λών ήταν π.χ. στα ελληνικά (αν αναφέρεστε μόνο στην ελληνική αγορά).
Προτού μπορέσουμε να τροποποιήσουμε μια εφαρμογή που δημιουργή-
θηκε από το scaffold, θα πρέπει να μάθουμε λίγα πράγματα για την αρχι-
τεκτονική μιας εφαρμογής RoR. Η εφαρμογή αυτή καθεαυτή βρίσκεται στο
φάκελο app. Εκεί θα βρείτε τους εξής υποφακέλους (μαζί με άλλους):

• models: περιλαμβάνει τα μοντέλα δεδομένων μας (π.χ. task.rb) που
αποθηκεύονται στη ΒΔ.

• views: είναι η πρόσοψη της εφαρμογής, η αναπαράσταση της πληρο-
φορίας στο χρήστη (συνήθως με τη μορφή ιστοσελίδων)

• controllers: είναι ο εγκέφαλος της εφαρμογής· αποφασίζει πώς θα
αλληλεπιδράσει ο χρήστης με την εφαρμογή ελέγχοντας ποια δεδο-
μένα προσπελάζονται από το μοντέλο και ποια προβολή (view) θα τα
παρουσιάσει.

Μετά από τα παραπάνω, ποια αρχεία πιστεύετε ότι πρέπει ν’ αλλάξουμε;
Φυσικά, τα αρχεία στο φάκελο views. Τα αρχεία αυτά όμως δεν έχουν
κατάληξη .html όπως ίσως θα περιμένατε, αλλά .erb (Embedded Ruby),
ή αλλιώς πρότυπα σελίδων (page templates) δηλ. σελίδες HTML μαζί με
κώδικα που όταν εκτελούνται παράγουν τις ιστοσελίδες που βλέπετε στον
πλοηγό σας. Ανοίξτε καθένα από τα αρχεία .erb που βρίσκονται στο φά-
κελο views/tasks/ στον αγαπημένο σας κειμενογράφο και αλλάξτε τις
κεφαλίδες στα ελληνικά. Ανανεώνοντας τα περιεχόμενα του πλοηγού σας
βλέπετε αμέσως τις αλλαγές. Δείτε πως μ’ αυτόν τον τρόπο επιταχύνεται ο
χρόνος ανάπτυξης, καθώς δε χρειάζεται να μεταγλωττίσετε τον κώδικα και
να τον εγκαταστήσετε (deploy) στον διακομιστή όπως με άλλες γλώσσες.

Παρατήρηση! Ενδέχεται να βρείτε στο αρχείο _form.html.erb εντολές
της μορφής <%= f.label :Description %><br /> τις οποίες μπορείτε
ν’ αλλάξετε σε <%= f.label :Περιγραφή %><br /> . Για τον παρα-
τηρητικό αναγνώστη, το :Description είναι επίσης αλφαριθμητικό το οποίο
ονομάζεται σύμβολο στη Ruby. Απλά αν ο τίτλος σας έχει κενά, καλό είναι
να τον βάλετε μέσα σε εισαγωγικά, π.χ. :”Ημερομηνία παράδοσης”.
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Τα πάντα ρει

Όπως ίσως γνωρίζετε, τίποτα δε μένει στατικό σ’ αυτόν τον κόσμο, ούτε
οι προδιαγραφές, οι οποίες συνέχεια αλλάζουν και πρέπει να αλλάζουμε και
τις εφαρμογές λογισμικού για να τις ικανοποιήσουμε. Οι πελάτες μας ζητή-
σανε να προσθέσουμε μια νέα στήλη που να δηλώνει αν ένα έργο ολοκλη-
ρώθηκε ή όχι. Εδώ θα καταλάβετε τι είναι η μετάβαση (migration).

..

$ rails generate migration AddCompletedToTasks completed:

boolean

$ rake db:migrate

== AddCompletedToTasks: migrating

=========================================

-- add_column(:tasks, :completed, :boolean)

-> 0.0090s

== AddCompletedToTasks: migrated (0.0096s)

=========================================

Η πρώτη εντολή δημιούργησε το ακόλουθο αρχείο στο φάκελο
db/migrate:

..

class AddCompletedToTasks < ActiveRecord::Migration

def change

add_column :tasks, :completed, :boolean

end

end

db/migrate/20121022201252_add_completed_to_tasks.rb

ενώ η δεύτερη εντολή εκτέλεσε τη μετάβαση κατά τα γνωστά. Η εντολή
αυτή καταλαβαίνει από το timestamp της εντολής migrate ποια script με-
τάβασης έχουν ήδη εκτελεστεί και ποια όχι, και εκτελεί όσα δεν έχουν ήδη
εκτελεστεί και ενημερώνει κατάλληλα τη ΒΔ.
Και για ποιο λόγο δεν μπορούμε να δημιουργήσουμε αυτήν την αλλαγή

μόνοι μας και πρέπει να την κάνουμε μέσω της εντολής rake; Πέραν του
ότι μας γλυτώνει χρόνο, με την εντολή rake μπορούμε να επιστρέψουμε
σε μια προηγούμενη κατάσταση της εφαρμογής μας αν η τελευταία αλλαγή
που κάναμε δεν ήταν σωστή. Η rakeφροντίζει να κρατάει ένα στιγμιότυπο
της εφαρμογής μας ενημερώνοντας όλα τα αρχεία που χρειάζεται.

Μπορείτε ναδείτε τηναλλαγή είτε μπαίνοντας στοπεριβάλλον της sqlite3
από τη γραμμή εντολών, είτε χρησιμοποιώντας κάποιο γραφικό εργαλείο
όπως ο SQLite Database Browser ή το πρόσθετο (plugin) SQLiteManager
για Firefox (ανοίξτε το από το μενού του Firefox Tools→ SQLite Manager
και στη συνέχεια από το μενού Tools → Options του εργαλείου αλλάξτε
την εξ ορισμού επέκταση από sqlite σε sqlite3). Το αρχείο που πρέπει
να ανοίξετε είναι το db/development.sqlite3.
Επίσης, το AddCompletedToTasks δεν είναι τυχαίο. Αποτελεί άλλη

μια σύμβαση της RoR, η οποία της λέει να προσθέσει ένα νέο πε-
δίο completed στον πίνακα tasks. Αντίστοιχες συμβάσεις είναι π.χ. η
RemoveCompletedFromTasks.
Από εκεί και πέρα θα πρέπει να αλλάξετε μόνοι σας τα αρχεία .erb προ-

σθέτοντας το νέο πεδίο για να εμφανιστούν οι αλλαγές στον πλοηγό.
Ελέγξτε αν το μοντέλο app/models/task.rb περιέχει το νέο πεδίο

:completed. Αν όχι, τότε κάτι πήγε στραβά κατά τη μετάβαση και πρέ-
πει να το προσθέσετε για να δουλέψει η εφαρμογή με τις αλλαγές. Επίσης,
θα πρέπει να προσθέσετε το νέο πεδίο στις φόρμες που βρίσκονται στο
app/views/tasks/ (αφήνεται ως άσκηση στον αναγνώστη).

Αντιστοίχιση Σχεσιακού με Αντικειμενοστραφές μο-

ντέλο

Η κλάση Task του μοντέλου μας κληρονομεί από την κλάση
ActiveRecord.

..

class Task < ActiveRecord::Base

attr_accessible :alert, :completed, :daysBefore, :

description, :details, :dueDate, :priority

end

Ηκλάσηαυτήαντιστοιχίζει πίνακες με κλάσεις, εγγραφέςμεαντικείμενακαι
στήλες με ιδιότητες αντικειμένων (βλ. Σχήμα 4). Αυτή η τεχνική είναι γνω-
στήωςObject-RelationalMapping (ORM). Καθώς τα ΣΔΒΔ χρησιμοποιούν το
σχεσιακό μοντέλο (βλ. SQL) και η Ruby το αντικειμενοστραφές μοντέλο, το
ActiveRecord αποτελεί τη γέφυρα μεταξύ των δυο.
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Εικόνα 4: Object-Relational Mapping (ORM)

Δυο δρόμους έχει η ζωή

Ο προσεχτικός αναγνώστης θα παρατήρησε ότι προσπελά-
σαμε την εφαρμογή μας δίνοντας http://localhost:3000/tasks κι όχι
http://localhost:3000. Η RoR συνάγει από τη διεύθυνση (URL) ποιον κώδικα
να εκτελέσει βασισμένη σε ορισμένους κανόνες. Είναι από τις πολύ λίγες
φορές που θα πρέπει να ρυθμίσετε (configure) τη RoR κι όχι να βασιστείτε
σε συμβάσεις (conventions). Οι κανόνες που χρησιμοποιεί η RoR για να
αντιστοιχίσει διευθύνσεις URL σε κώδικα λέγονται διαδρομές (routes) και
ορίζονται στο πρόγραμμα Ruby config/routes.rb. Για να μπορείτε να
προσπελάσετε την εφαρμογή δίνοντας http://localhost:3000, αναζητήστε
την παρακάτω γραμμή που ξεκινάει με root και αλλάξτε τη στην παρακάτω
(βλ. http://guides.rubyonrails.org/routing.html):

..
root :to => ’tasks#index’

Η γραμμή αυτή λέει στη RoR να καλέσει την ιστοσελίδα index του ελεγκτή
tasks όταν ο χρήστης καλέσει την αρχή (ρίζα) της εφαρμογής. Για να δου-
λέψει, πρέπει να κάνετε κάτι ακόμα:

..
$ rm public/index.html

Έλεγχος εισαγωγής δεδομένων

Ο παρατηρητικός αναγνώστης θα πρόσεξε επίσης ότι μπορούμε να
δημιουργήσουμε κενά έργα, δηλ. χωρίς περιγραφή κλπ. Ας δούμε
πώς μπορούμε να εισάγουμε ελέγχους κατά την εισαγωγή των δε-
δομένων. Οι έλεγχοι γίνονται στο επίπεδο του μοντέλου. Ανοίξτε το
αρχείο app/models/task.rb και αλλάξτε το όπως παρακάτω (βλ.
http://guides.rubyonrails.org/active_record_validations_callbacks.html):

..

class Task < ActiveRecord::Base

validates :dueDate, :presence => true

validates :description, :presence => true,

:length => { :minimum => 5 }

validates :priority, :numericality => { :only_integer =>

true, :greater_than_or_equal_to => 0, :

less_than_or_equal_to => 100 }

end

Επίσης, παρατηρήστε ότι ο οποιοσδήποτε μπορεί να εισάγει και να τρο-
ποποιεί έργα. Θα προσθέσουμε έναν απλό (κι όχι ασφαλή) έλεγχο ότι
μόνο όποιος γνωρίζει τον κωδικό του διαχειριστή μπορεί να εισάγει/τρο-
ποποιεί έργα και θα δούμε στο επόμενο τεύχος έναν ασφαλή τρόπο με
διαχείριση χρηστών. Προσθέστε την παρακάτω γραμμή στον ελεγκτή (βλ.
http://guides.rubyonrails.org/security.html):

..

class TasksController < ApplicationController

http_basic_authenticate_with :name => ”admin”, :password =>

”admin”, :except => [:index, :show]

...

Τώρα, την πρώτη φορά που θα προσπαθήσετε να εισάγετε/τροποποιή-
σετε ένα έργο, εμφανίζεται ένα παράθυρο που σας ζητάει να εισάγετε ένα
όνομα χρήστη κι ένα κωδικό. Αν εισάγετε τα σωστά admin/admin τότε
μπορείτε να εκτελέσετε τις παραπάνω ενέργειες. Στο επόμενο τεύχος θα
δούμε πώς να προσθέσουμε χρήστες και πώς να κάνουμε την εφαρμογή
μας ασφαλή από κυβερνοεπιθέσεις.
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Επεξήγηση της εφαρμογής

Όπως είδαμε, η εντολή scaffold δημιούργησε μια ολόκληρη εφαρμογή
για μας. Για να μπορέσουμε όμως να την τροποποιήσουμε ώστε να ικανο-
ποιεί τις τωρινές και μελλοντικές απαιτήσεις μας, θα πρέπει να κατανοή-
σουμε πώς δουλεύει.
Ας δούμε ένα σενάριο:

1. Ο χρήστης εισάγει στον πλοηγό του τη διεύθυνση:
http://localhost:3000/ .

2. ΗRoRπερνάει τηναίτηση του χρήστηστοαρχείοconfig/routes.rb.

3. Η αίτηση ταυτίζεται με τη γραμμή:
root :to => ’tasks#index’ η οποία της λέει να καλέσει την μέ-
θοδο index του ελεγκτή tasks.

4. Η μέθοδος index της κλάσης TasksController
(app/controllers/tasks_controllers.rb):

..

# GET /tasks

# GET /tasks.json

def index

@tasks = Task.all

respond_to do |format|

format.html # index.html.erb

format.json { render json: @tasks }

end

end

ανακτά όλες τις εγγραφές τύπου Task από τη ΒΔ (Task.all) και τις
αποθηκεύει στη δομή πίνακα @tasks. Στη συνέχεια εμφανίζει τη σε-
λίδα index. Παρατηρήστε ότι αντίστοιχα ισχύουν αν λάβει μια αίτηση
τύπου json (π.χ. http://localhost:3000/posts.json).

5. Η πρότυπη σελίδα app/views/tasks/index.html.erb καλείται
στη συνέχεια:

..

<% @tasks.each do |task| %>

<tr>

<td><%= task.description %></td>

...

</tr>

<% end %>

η οποία προσπελάζει ένα ένα τα έργα από τον πίνακα @tasks, που γέ-
μισε προηγουμένως ο ελεγκτής, και εμφανίζει τις ιδιότητες καθενός έρ-
γου σε πινακοειδή μορφή HTML.

Ο κώδικας μεταξύ<%= και%>ονομάζεται έκφραση. Όπως καταλαβαίνετε,
η παραπάνω έκφραση απλά διαβάζει την ιδιότητα description του αντι-
κειμένου @task και την εμφανίζει στην πρώτη στήλη του πίνακα HTML. Αν
θέλουμε να εμφανίσουμε πιο πολύπλοκη πληροφορία, τότε μπορούμε να
χρησιμοποιήσουμε τα scriplets: <% και %> (παρατηρήστε ότι δεν υπάρχει το
=), όπως φαίνεται πιο πάνω κατά την προσπέλαση των δεδομένων του πί-
νακα @tasks.
Παρατηρήστε ότι το όνομα του αρχείου index.html.erb ταυτίζεται με

το όνομα της μεθόδου index του TasksController.

• link_to δημιουργεί έναν υπερσύνδεσμο

• edit_task_path και new_task_path είναι βοηθήματα (helpers).

Ας δούμε ένα ακόμα σενάριο:

1. Ο χρήστης εισάγει στον πλοηγό του τη διεύθυνση:
http://localhost:3000/tasks/1.

2. ΗRoRπερνάει τηναίτηση του χρήστηστοαρχείοconfig/routes.rb.

3. Η αίτηση ταυτίζεται με τη γραμμή:
resources :tasks (η οποία μεταφράζεται στη γραμμή match
’tasks/:id’ =>’tasks#show’) η οποία της λέει να καλέσει τη μέ-
θοδο show του ελεγκτή tasks.

4. Η μέθοδος show της κλάσης TasksController:
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..

# GET /tasks/1

# GET /tasks/1.json

def show

@task = Task.find(params[:id])

respond_to do |format|

format.html # show.html.erb

format.json { render json: @task }

end

end

ανακτά την εγγραφή Task με :id=1 από τη ΒΔ περνώντας
τυχόν παραμέτρους στον πίνακα κατακερματισμού params
(Task.find(params[:id], στη συγκεκριμένη περίπτωση η
params[:id] = params[1] που αντιστοιχεί στην 1η εγγραφή
του πίνακα tasks) και την αποθηκεύει στη μεταβλητή @task. (Εδώ,
γίνεται ένα Object Relational Mapping μεταξύ των στηλών μιας
εγγραφής του πίνακα tasks και των ιδιοτήτων του αντικειμένου
@task, π.χ. τα δεδομένα της στήλης Description της 1ης εγγραφής
αποθηκεύονται στο πεδίο @task.description, βλ. Eικόνα 4). Στη
συνέχεια, εμφανίζει τη σελίδα show.

Η params είναι ένας πίνακας κατακερματισμού (hashtable), ο οποίος
περιέχει ταδεδομένα της εκάστοτεφόρμας (τα κλειδιάδιαφέρουνανά-
λογα με την περίπτωση), π.χ.:

params

Κλειδί (key) Τιμή (value)

id 1

action “show”

controller “tasks”
Πίνακας 3: Πίνακας κατακερματισμού params

5. Η πρότυπη σελίδα app/views/tasks/show.html.erb καλείται στη
συνέχεια:

..

<p>

<b>Id:</b>

<%= @task.id %>

</p>

...

η οποία εμφανίζει τις ιδιότητες του έργου που έχουν αποθηκευθεί στη
μεταβλητή @task σε μορφή HTML.

Ας δούμε τώρα την περίπτωση που ο χρήστης θέλει να δημιουργήσει ένα
νέο έργο:

1. Ο χρήστης επιλέγει τον υπερσύνδεσμο New Task ο οποίος δείχνει στο
http://localhost:3000/tasks/new/ .

2. Η αίτηση στέλνεται στο routes.rb. Η διαδρομή tasks/new αντιστοι-
χείται με τη μέθοδο new του ελεγκτή tasks.

3. Η μέθοδος new της κλάσης TasksController:

..

# GET /tasks/new

# GET /tasks/new.json

def new

@task = Task.new

respond_to do |format|

format.html # new.html.erb

format.json { render json: @task }

end

end

δημιουργεί ένα νέο κενό έργο, το οποίο αποθηκεύει στη μεταβλητή
@task, και εμφανίζει τη σελίδα new. Είναι σημαντικό να δημιουργηθεί
ένα νέο Task το οποίο θ’ εμφανίσει τυχόν δεδομένα (στην περίπτωση
edit) στη φόρμα εισαγωγής προτού εμφανιστεί η φόρμα εισαγωγής,
αλλιώς θα δημιουργηθεί ένα λάθος ότι @task.id = nil.

4. Εμφανίζεται η φόρμα εισαγωγής new.html.erb
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..

<h1>New task</h1>

<%= render ’form’ %>

<%= link_to ’Back’, tasks_path %>

η οποία βασίζεται στη μερική (partial) φόρμα _form.html.erb. Η τε-
λευταία είναι κοινή φόρμα των new.html.erb και edit.html.erb
καθώς η μορφή τους είναι πανομοιότυπη (DRY).

..

<%= form_for(@task) do |f| %>

...

<div class=”field”>

<%= f.label :description %><br />

<%= f.text_field :description %>

</div>

...

<div class=”actions”>

<%= f.submit %>

</div>

<% end %>

5. Όταν ο χρήστης πατήσει το κουμπί υποβολής Submit, η φόρμα καλεί
την αντίστοιχη ενέργεια <%= f.submit %> η οποία δημιουργεί την
αίτηση tasks/create η οποία ταυτίζεται (routes.rb) με τη μέθοδο
create του ελεγκτή tasks:

..

# POST /tasks

# POST /tasks.json

def create

@task = Task.new(params[:task])

respond_to do |format|

if @task.save

format.html { redirect_to @task, notice: ’Task

was successfully created.’ }

format.json { render json: @task, status: :

created, location: @task }

..

else

format.html { render action: ”new” }

format.json { render json: @task.errors, status:

:unprocessable_entity }

end

end

end

Η μέθοδος αυτή δημιουργεί ένα νέο αντικείμενο @task από τα δεδο-
μένα της φόρμας, το αποθηκεύει στη ΒΔ (@task.save) και επανακα-
τευθύνει (redirect_to) το χρήστη στην ιστοσελίδα show (@task) εμ-
φανίζοντας ένα (flash) μήνυμα (notice) στην κορυφή της. Αν κάτι πήγε
στραβά, τότε εμφανίζει πάλι τη σελίδα new.

Η περίπτωση που ο χρήστης θέλει να αλλάξει τα δεδομένα ενός έργου
μοιάζει με την προηγούμενη περίπτωση:

1. Ο χρήστης πατάει τον υπερσύνδεσμο Edit ο οποίος δείχνει στο
http://localhost:3000/tasks/:id/edit/ .

2. Η αίτηση στέλνεται στο routes.rb. Η διαδρομή tasks/:id/edit
αντιστοιχίζεται με τη μέθοδο edit του ελεγκτή tasks.

3. Η μέθοδος edit της κλάσης TasksController:

..

# GET /tasks/1/edit

def edit

@task = Task.find(params[:id])

end

ανακτά το έργο με :id=1, το αποθηκεύει στη μεταβλητή @task και εμ-
φανίζει τη σελίδα edit.

4. Εμφανίζεται η φόρμα εισαγωγής edit.html.erb η οποία βασίζεται
στη μερική (partial) φόρμα _form.html.erb.

5. Όταν ο χρήστης πατήσει το κουμπί υποβολής Submit, η φόρμα καλεί
την αντίστοιχη ενέργεια <%= f.submit %> η οποία δημιουργεί την αί-
τηση tasks/:id/update που ταυτίζεται (routes.rb) με τη μέθοδο
update του ελεγκτή tasks:
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..

# GET /tasks/1/edit

# PUT /tasks/1/update

# POST /tasks.json

def update

@task = Task.find(params[:id])

respond_to do |format|

if @task.update_attributes(params[:task])

format.html { redirect_to @task, notice: ’Task

was successfully updated.’ }

format.json { head :no_content }

else

format.html { render action: ”edit” }

format.json { render json: @task.errors, status:

:unprocessable_entity }

end

end

end

Η μέθοδος αυτή ανακτά το έργο με :id=1 από τη ΒΔ και το
αποθηκεύει στην @task, το ενημερώνει με τα δεδομένα της φόρ-
μας (update_attributes(params[:task])) και επανακατευθύνει
(redirect_to) το χρήστη στην ιστοσελίδα show (@task) εμφανίζο-
ντας ένα flash μήνυμα (notice) στην κορυφή της ή πάλι τη φόρμα edit
σε περίπτωση λάθους. Η ενημέρωση του @task ενημερώνει αυτόματα
και την αντίστοιχη εγγραφή στον πίνακα tasks.

Η περίπτωση της διαγραφής αφήνεται ως άσκηση στον αναγνώστη.

Προσθέτοντας στυλ

Μπορείτε να προσθέσετε τα δικά σας στυλ CSS για να “ντύσετε” την
εφαρμογή σας στο φάκελο app/assets/stylesheets, τις εικόνες σας
στοφάκελοapp/assets/images και τυχόν κώδικα javascript στοφάκελο
app/assets/images.
Από κει και πέρα χρειάζεται να τροποποιήσετε την πρότυπη σελίδα

app/views/layouts/application.html.erb βάσει της οποίας μοιά-

ζουν όλες οι ιστοσελίδες της εφαρμογής σας ή να δημιουργήσετε τη δική
σας.

..

<!DOCTYPE html>

<html>

<head>

<title>Todo</title>

<%= stylesheet_link_tag ”application”, :media => ”all”

%>

<%= javascript_include_tag ”application” %>

<%= csrf_meta_tags %>

</head>

<body>

<%= yield %>

</body>

</html>

Αλλάξτε το application css με το δικό σας στη γραμμή:

..
<%= stylesheet_link_tag ”application”, :media => ”all” %>

Ο παρατηρητικός αναγνώστης θα παρατηρήσει ότι το παραπάνω πρό-
τυπο ακολουθεί τη σύνταξη της HTML 5, για την οποία μπορείτε να διαβά-
σετε σε άλλες σελίδες του περιοδικού.

Τροποποιώντας την πρότυπη εφαρμογή

Και να που έρχεται μια νέα απαίτηση: “για κάθε έργο (Task) απαιτείται
ένας αριθμός ενεργειών (Actions) για να ολοκληρωθεί. Μια ενέργεια απο-
τελείται από μια περιγραφή και σε ποιον ανατίθεται για να εκπληρωθεί”.
Φυσικά ξεκινάμε από το μοντέλο (μην εκτελέσετε την παρακάτω

εντολή!):

..

$ rails generate model Action description:text assignee:

string task:references
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Aν και η παραπάνω εντολή φαίνεται εντελώς αθώα, ονομάζοντας την
κλάση μας Action θα μας δημιουργήσει προβλήματα αργότερα. Ο λόγος
είναι ότι ο πίνακας κατακερματισμού params περιέχει ένα κλειδί action
(βλ. πίνακα 3) κι όταν θα πάμε να δημιουργήσουμε μια νέα ενέργεια, αυτή
θαπροσπαθήσει ν’ αποθηκευθεί μεκλειδίactionστονparams. Αυτόόμως
δε θα γίνει, το κλειδί action θα περιέχει την τιμή “create” κι όχι τα δεδο-
μένα της ενέργειας που καταχωρήσαμε στη φόρμα μας, με αποτέλεσμα η
εφαρμογή μας να μη δουλεύει. Εγώ την έπαθα και μου πήρε κάμποση ώρα
να καταλάβω τι συμβαίνει. Αν η παραπάνω επεξήγηση δεν σας βοήθησε να
καταλάβετε ποιο είναι το πρόβλημα, δεν πειράζει, αρκεί να ονομάσετε το
μοντέλο σας π.χ. Activity ή κάτι άλλο, πάντως όχι Action.

..

$ rails generate model Activity description:text assignee:

string task:references

Η παραπάνω εντολή δημιούργησε τα αρχεία app/models/activity.rb
και db/migrate/..._create_activities.rb.

..

class Activity < ActiveRecord::Base

belongs_to :task

attr_accessible :assignee, :description

end

Η γραμμή belongs_to :task ορίζει μια σχέση που δηλώνει ότι μια ενέρ-
γεια ανήκει σ’ ένα έργο. Πρέπει όμως να δηλώσουμε αυτή τη σχέση και στο
άλλο μοντέλο:

..

class Task < ActiveRecord::Base

attr_accessible :alert, :completed, :daysBefore, :

description, :details, :dueDate, :priority

validates :dueDate, :presence => true

validates :description, :presence => true,

:length => { :minimum => 5 }

validates :priority, :numericality => { :only_integer =>

true, :greater_than_or_equal_to => 0, :

less_than_or_equal_to => 100 }

has_many :activities

..

end

όπως φαίνεται από την εντολή has_many :activities.

Εικόνα 5: Διάγραμμα κλάσεων της εφαρμογής

db/migrate/..._create_activities.rb:

..

class CreateActivities < ActiveRecord::Migration

def change

create_table :activities do |t|

t.text :description

t.string :assignee

t.references :task

t.timestamps

end

add_index :activities, :task_id

end

end

Ηγραμμήt.referencesδημιουργεί ένα ξένο κλειδί για τησχέσηανάμεσα
στα δυο μοντέλα, ενώ η γραμμή add_index δημιουργεί ένα ευρετήριο για
αυτή τη στήλη.
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Εικόνα 6: Διάγραμμα οντοτήτων συσχετίσεων

Η εντολή:

..
$ rake db:migrate

δημιούργησε τον πίνακα activities εκτελώντας το παραπάνω script.
Στη συνέχεια, ο ελεγκτής δημιουργείται με την εντολή:

..
$ rails generate controller activities

ηοποίαδημιουργεί τοαρχείοapp/controllers/activities_controll
er.rb.
Χρειάζεται να ενημερώσουμε και το routes.rbως εξής:

..

resources :tasks do

resources :activities

end

Στη συνέχεια θα ενημερώσουμε την όψη show.html.erb ώστε να μπο-
ρούμε να εισάγουμε μια νέα ενέργεια: ..

...

<p>

<b>Completed:</b>

<%= @task.completed %>

</p>

<h2>Actions</h2>

<% @task.activities.each do |activity| %>

<p>

<b>Description:</b>

<%= activity.description %>

</p>

<p>

<b>Assignee:</b>

<%= activity.assignee %>

</p>

<% end %>

<h2>Add an action:</h2>

<%= form_for([@task, @task.activities.build]) do |f| %>

<div class=”field”>

<%= f.label :description %><br />

<%= f.text_area :description %>

</div>

<div class=”field”>

<%= f.label :assignee %><br />

<%= f.text_field :assignee %>

</div>

<div class=”actions”>

<%= f.submit %>

</div>

<% end %>

<%= link_to ’Edit’, edit_task_path(@task) %> |

<%= link_to ’Back’, tasks_path %>
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Ο παραπάνω κώδικας προσθέτει μια νέα φόρμα στη σελίδα show, η οποία
δημιουργεί μια νέα ενέργεια καλώντας τη μέθοδο create του ελεγκτή
ActivitiesController:

..

class ActivitiesController < ApplicationController

def create

@task = Task.find(params[:task_id])

@activity = @task.activities.create(params[:activity])

redirect_to task_path(@task)

end

end

Η παραπάνω εντολή ανακτά από το μοντέλο (Task) την εγγραφή
:task_id, δημιουργεί μια νέα ενέργεια (@activity) από τα στοιχεία της
φόρμας και ανακατευθύνει το χρήστη πίσω στη σελίδα show (@task). Εδώ
είναι το σημείο όπου αν ονομάζαμε το μοντέλο μας Action, η εντολή
params([:action]) θα επέστρεφε ”create” αντί για τα δεδομένα της
φόρμας, με αποτέλεσμα η εφαρμογή μας να μη δουλεύει σωστά.
Μπορούμε να βελτιώσουμε την αναγνωσιμότητα του αρχείου

show.html.erb μεταφέροντας τον κώδικα των ενεργειών σε μερι-
κές φόρμες (partials):
app/views/activities/_activity.html.erb

..

<p>

<b>Description:</b>

<%= activity.description %>

</p>

<p>

<b>Assignee:</b>

<%= activity.assignee %>

</p>

και
app/views/activities/_form.html.erb

..

<%= form_for([@task, @task.activities.build]) do |f| %>

<div class=”field”>

<%= f.label :description %><br />

..

<%= f.text_area :description %>

</div>

<div class=”field”>

<%= f.label :assignee %><br />

<%= f.text_field :assignee %>

</div>

<div class=”actions”>

<%= f.submit %>

</div>

<% end %>

τροποποιώντας την show.html.erbως εξής:

..

...

<p>

<b>Completed:</b>

<%= @task.completed %>

</p>

<h2>Actions</h2>

<%= render @task.activities %>

<h2>Add an action:</h2>

<%= render ”activities/form” %>

<%= link_to ’Edit’, edit_task_path(@task) %> |

<%= link_to ’Back’, tasks_path %>

Ως τελευταίο βήμα, θα προσθέσουμε τη δυνατότητα, όποιος γνωρίζει τον
κωδικό του διαχειριστή, να μπορεί να διαγράψει ενέργειες.
Ξεκινάμε προσθέτοντας έναν υπερσύνδεσμο διαγραφής μιας ενέργειας

στη φόρμα _activity:

..

<p>

<%= link_to ’Delete Action’,

[activity.task, activity],

:confirm => ’Are you sure?’,

:method => :delete %>
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..
</p>

ο οποίος θα στείλει μια αίτηση DELETE /tasks/:id/activities/:id
στονActivitiesController, στον οποίο πρέπει να προσθέσουμε τη νέα
μέθοδο:

..

class TasksController < ApplicationController

http_basic_authenticate_with :name => ”admin”, :password =>

”admin”, :only => :destroy

...

def destroy

@task = Task.find(params[:task_id])

@activity = @task.activities.find(params[:id])

@activity.destroy

redirect_to task_path(@task)

end

end

Τέλος, θα πρέπει να μεριμνήσουμε ώστε στην περίπτωση που διαγραφεί
ένα έργο, να διαγραφούν και οι σχετικές ενέργειες:
app/models/task.rb

..

class Task < ActiveRecord::Base

...

has_many :activities, :dependent => :destroy

end

Προς παραγωγή

Κάποια στιγμή θ’ αποφασίσετε ότι η εφαρμογή σας είναι έτοιμη προς πα-
ραγωγή. Θα πρέπει να την εγκαταστήσετε στον διακομιστή παραγωγής και
να τη ρυθμίσετε ώστε να δουλεύει με τη ΒΔ παραγωγής (MySQL στο παρά-
δειγμά μας).
Ανοίξτε το αρχείο config/database.yml:

..

development:

adapter: sqlite3

..

database: db/development.sqlite3

pool: 5

timeout: 5000

test:

adapter: sqlite3

database: db/test.sqlite3

pool: 5

timeout: 5000

production:

adapter: sqlite3

database: db/production.sqlite3

pool: 5

timeout: 5000

Παρατηρήστε ότι ορίζονται τρεις ΒΔ, μια για ανάπτυξη, μια για testing και
μια για παραγωγή.
Τροποποιήστε τη ΒΔ παραγωγής ως ακολούθως:

..

production:

adapter: mysql2

encoding: utf8

database: todo_production

pool: 5

username: root

password:

socket: /var/run/mysqld/mysqld.sock

ή socket: /opt/lampp/var/mysql/mysqld.sock αν χρησιμοποιείτε
lampp.
Για να δημιουργήσετε τη ΒΔ παραγωγής, δώστε τις εντολές:

..

$ rake db:create RAILS_ENV=”production”

$ rake db:migrate RAILS_ENV=”production”

Θα πρέπει να έχετε εγκαταστήσει:
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..

$ sudo apt-get install libmysql-ruby

$ sudo apt-get install libmysqlclient-dev

$ sudo gem install mysql

$ sudo gem install activerecord-mysql2-adapter

Αν παρ’ όλ’ αυτά συνεχίζει να παραπονιέται ότι δε βρίσκει τη mysql2, τότε
προσθέστε στο αρχείο Gemfile κάτω από τη γραμμή gem ’rails’ τη
γραμμή:

..
gem ’mysql2’, ’~> 0.3.10’

και από το κέλυφος δώστε:

..

$ bundle install

$ bundle show mysql2

Αν όλα πήγαν καλά, τότε θα πρέπει να δημιουργήθηκε η ΒΔ
todo_production στη MySQL.

Ολοκληρωμένα Περιβάλλοντα Εργασίας (ΟΠE)

Όπως είδαμε σ’ αυτό το άρθρο, μπορείτε να αναπτύξετε μια εφαρμογή
RoR από τη γραμμή εντολών. Υπάρχουν όμως και ολοκληρωμένα περιβάλ-
λοντα εργασίας που σας βοηθούν σ’ αυτή τη δουλειά:

• RadRails (http://www.aptana.com/products/radrails) – δωρεάν

• RubyMine (http://www.jetbrains.com/ruby/index.html)

• 3rdRail (http://www.embarcadero.com/products/3rdrail)

• NetBeans (http://netbeans.org/features/ruby/index.html) – δωρεάν

και φυσικά οι αγαπημένοι σας κειμενογράφοι vim και emacs διαθέτουν πρό-
σθετα για υποστήριξη RoR.
Ένα ΟΠΕ μπορεί ν’ αποβεί ιδιαίτερα χρήσιμο, πέραν των άλλων, κατά την

αποσφαλμάτωση της εφαρμογής σας (όταν π.χ. ψάχνετε να βρείτε γιατί η
params([:action]) δεν επιστρέφει αυτό που περιμένατε).

Επίλογος

Σ’ αυτό το άρθρο είδαμε πώς μπορούμε να αναπτύξουμε εφαρμογές
ιστού γρήγορα και αποτελεσματικά με τη Ruby on Rails. Μιλήσαμε για την
αρχιτεκτονική Model-View-Controller (MVC) που ακολουθεί η RoR, τη σύμ-
βαση αντί για τη ρύθμιση, και αναπτύξαμε μια μικρή εφαρμογή ιστού. Αν και
δεν καλύψαμε όλες τις απαιτήσεις, όπως π.χ.

• Θα πρέπει να υπάρχουν οπτικές ενδείξεις για έργα που έχει περάσει η προ-
θεσμία τους ή είναι έτοιμα να λήξουν

• Τα έργα μπορούν να μαρκαριστούν ότι έχουν ολοκληρωθεί, αλλά αυτό δε
σημαίνει ότι θα διαγραφούν ή δε θα εμφανίζονται εκτός κι αν ο χρήστης
επιλέξει να τα διαγράψει

πλέον ο αναγνώστης έχει αποκτήσει τις απαραίτητες γνώσεις για να τις υλο-
ποιήσει.
Η εφαρμογή μας ωστόσο καθετί άλλο παρά ασφαλής μπορεί να χαρα-

κτηριστεί. Ο καθένας μπορεί να πλοηγηθεί στα έργα άλλων χρηστών και
σχετικά εύκολα μπορεί να παραβιάσει το παράθυρο αυθεντικοποίησης που
του επιτρέπει να αλλάξει ή να διαγράψει έργα και ενέργειες. Στο επόμενο
τεύχος θα προσθέσουμε δυνατότητες εγγραφής και σύνδεσης χρηστών και
θα δούμε τι τεχνικές μπορεί να χρησιμοποιήσει ένας επίδοξος χάκερ για να
μπει και να τροποποιήσει την εφαρμογή χωρίς να του έχει δοθεί πρόσβαση
σ’ αυτή. Και, φυσικά, πώς να προστατευτούμε από τέτοιες ενέργειες.

Πηγές:

1. Ruby on Rails, http://rubyonrails.org/ .

2. Guides, http://guides.rubyonrails.org/ .

3. Carneiro C. Jr., Al Barazi R. (2010), Beginning Rails 3, Apress.

4. Griffiths, D. (2009), Head First Rails, O’ Reilly.
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Εισαγωγή στην HTML 5 (Μέρος 1ο) του Γιάννη Κωστάρα

Εισαγωγή

Η HTML 5 είναι γεγονός. Περισσότερα από δέκα χρόνια μετά την προη-

γούμενη έκδοση 4.01 (1999), το W3C consortium προχωρεί στην επόμενη

έκδοση της HTML με πλούσια χαρακτηριστικά και πολλή Javascript. Σιγά τα

ωά θα μου πείτε. Ναι, αλλά αντί να γράφουμε Javascript για να καλύψουμε

τα διαφορετικά τερτίπια κάθε πλοηγού, τώρα θα γράφουμε στη standard

Javascript που θα την υποστηρίζουν όλοι οι browsers. Με απλά λόγια:

HTML 5 = HTML5 + JavaScript + CSS3

Αυτή τη στιγμή, λίγα χαρακτηριστικά της γλώσσας υποστηρίζονται από

τους πιο δημοφιλείς πλοηγούς (Chrome, Firefox, Opera, Safari και Internet

Explorer).

Συνοπτικά, η HTML 5 φέρνει τα εξής νέα στοιχεία (χάρη στην Javascript,

που πλέον έχει τυποποιηθεί και μέσω αυτής έχουμε πρόσβαση στα ακό-

λουθα APIs):

• Καμβάς (canvas) για να ζωγραφίζετε

• Δυνατότητα Σύρε & Ρίξε (Drag & Drop)

• Γεωκαταχώρηση, παίζει με Google maps

• Offline caching, όταν δεν είστε συνδεδεμένοι στο διαδίκτυο

• WebWorkers, όπου η πολυεπεξεργασία έρχεται στον πλοηγό

• Web Sockets, μια διπλής κατεύθυνσης σύνδεση με τον διακομιστή

• Νέες εντολές εισαγωγήςφορμών (επιλογέας χρώματος, επιλογέας ημε-

ρομηνίας, πεδίο κειμένου ηλεκτρονικού ταχυδρομείου, κλπ.)

• Υποστήριξη για ήχο και βίντεο χωρίς την ανάγκη plugins, όπως

QuickTime και Flash

• Τοπική αποθήκευση, και πείτε αντίο στα κουλουράκια (cookies)

• Αποστολή μηνυμάτων σε διάφορα μέρη μιας ιστοσελίδας

• νέες ετικέτες (tags), καθώς και ετικέτες που καταργούνται στην έκδοση

5.

Αυτό που πρέπει να υπογραμμίσουμε είναι ότι ακόμα οι προδιαγραφές εί-

ναι σε μορφήπρόχειρου (draft) και θαμείνουν έτσι για πολλά χρόνιαακόμα,

αλλά αυτό δε σημαίνει ότι οι πιο δημοφιλείς πλοηγοί δεν τις υποστηρίζουν

ήδη, σε μικρότερο ή μεγαλύτεροβαθμό. Στη συνέχεια θα περιγράψουμε με-

ρικές από αυτές.

Το μόνο που χρειάζεστε είναι ένας απλός κειμενογράφος και ένας πλοη-

γός που υποστηρίζει τη νέα έκδοση της HTML. Ελέγξτε την ιστοσελίδα

http://deepbluesky.com/blog/-/browser-support-for- css3-and-html5_72/ για

να δείτε την υποστήριξη των πιο δημοφιλών πλοηγών. Επίσης, πλοηγηθείτε

στην ιστοσελίδα http://html5test.com/ για να δείτε το σκορ του πλοηγού

σας όσον αφορά την υποστήριξη HTML 5. Για πιο αναλυτικά αποτελέσματα,

δείτε την ιστοσελίδα http://fmbip.com/ (χρειάζεται να έχετε ενεργοποιη-

μένη την Javascript στον πλοηγό σας). Τέλος, αν ένας απλός κειμενογράφος

δεν σας ικανοποιεί, ανατρέξτε στην επόμενη ενότητα, όπου παρέχεται μια
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λίστα κειμενογράφων για το Ubuntu που υποστηρίζουν την HTML 5.

Σημείωση! Το άρθρο αυτό υποθέτει ότι γνωρίζετε την HTML 4, ή τουλάχιστον
μια παλαιότερη έκδοσή της, και παρουσιάζει μόνο τα νέα χαρακτηριστικά που
φέρνει η έκδοση 5. Επίσης, προαπαιτεί κάποιες γνώσεις Javascript.

Κειμενογράφοι HTML 5

Υπάρχουν ήδη κειμενογράφοι που υποστηρίζουν τη σύνταξη της HTML 5:

• Aloha, ένας κειμενογράφος ενσωματωμένος στον πλοηγό σας, γραμμέ-
νος σε Javascript

• Aptana Studio 3, ένα δωρεάνολοκληρωμένοπεριβάλλον εργασίας που
υποστηρίζει HTML5, JavaScript, CSS3, Python, PHP, Rails και Ruby

• Bluefish, ο αγαπημένος σας κειμενογράφος τώρα και με υποστήριξη
HTML 5

• BlueGriffon, ένας δωρεάν WYSIWYG κειμενογράφος από την Gecko

• HTML5-editor, ένας δωρεάν WYSIWYG κειμενογράφος από την Silex,
γραμμένος σε php, που σημαίνει ότι θα χρειαστείτε έναν διακομιστή
Apache με ενεργοποιημένη την php (π.χ. xampp)

• Maqetta, άλλος ένας δωρεάν WYSIWYG κειμενογράφος

• Mercury, ένας δωρεάν κειμενογράφος που υποστηρίζει HTML5

• NetBeans, ένα δωρεάν ολοκληρωμένο περιβάλλον εργασίας που υπο-
στηρίζει HTML5 και CSS3

• WebStorm, ένας εμπορικός κειμενογράφος από την Jetbrains

Μια απλή ιστοσελίδα στην HTML 4.01 και την HTML 5

Μια ιστοσελίδα στην HTML 4.01 ξεκινούσε με την κεφαλίδα:

..

<!DOCTYPE html PUBLIC ”-//W3C//DTD HTML 4.01//EN”

”http://www.w3.org/TR/html4/strict.dtd”>

Στην HTML 5 απλά ξεκινάει με:

..
<!DOCTYPE html>

και δεν θα χρειαστεί να ξαναλλάξει!
Επίσης, η μετα-εντολή:

..

<meta http-equiv=”content-type” content=”text/html; charset=

UTF-8”>

απλοποιείται ως:

..
<meta charset=”utf-8”>

Ο υπερσύνδεσμος:

..
<link type=”text/css” rel=”stylesheet” href=”mycss.css”>

απλοποιείται ως εξής:

..
<link rel=”stylesheet” href=”mycss.css”>

Γιατί το Cascaded Stylesheet (CSS) είναι το εξ ορισμού πρότυπο στυλ στην
HTML 5.
Τέλος, καθώς η Javascript είναι η εξ ορισμού γλώσσα συνόδου της HTML 5,
η εντολή:

..
<script type=”text/javascript” src=”myscript.js”></script>

απλοποιείται ως:

..
<script src=”myscript.js”></script>

Το καλύτερο; Η νέα σύνταξη δουλεύει και σε παλαιότερους πλοηγούς!
Αλλά ας δούμε μερικά από τα πιο «καυτά» χαρακτηριστικά της νέας έκδο-
σης.
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Καμβάς - Ζωγραφική

Επιτέλους, μπορείτε να «βγάλετε» τον ζωγράφο που κρύβετε μέσα σας,
χρησιμοποιώντας τη νέα εντολή canvas:

..

<canvas height=”yyy” width=”xxx”>

</canvas>

Μπορείτε να βρείτε το πλήρες API στη διεύθυνση
http://www.w3.org/TR/html5/the-canvas-element.html, καθώς και στην
http://dev.w3.org/2006/canvas-api/canvas-2d-api.html. Όπως θα δείτε,
μπορείτε να ζωγραφίσετε ένα πλήθος σχημάτων (γραμμές, παραλληλό-
γραμμα, καμπύλες, τόξα, ελλείψεις, εικόνες, πολύπλοκα σχήματα, κ.ά.),
να ορίσετε στυλ γραμμών, να προσθέσετε σκιές, να χρησιμοποιήσετε
μετασχηματισμούς σχημάτων (περιστροφή, μεταφορά, κλπ.), και πολλά
άλλα ακόμη.

• Πλοηγοί που τον υποστηρίζουν: Chrome, Firefox, Opera, Safari.

Στη συνέχεια, θα δούμε… το ζωγράφο μέσα μου!

Εικόνα 1: Ένα παράδειγμα χρήσης του καμβά

Ας ξεκινήσουμε με τον ακόλουθο κώδικα, τον οποίο μπορείτε ν’ αποθη-
κεύσετε στο αρχείο canvas.html:

..

<!DOCTYPE html>

<html>

<head>

<title>Canvas Example</title>

<script type=”text/javascript”>

function loader()

{ }

</script>

</head>

<body onload=”loader()”>

<h1>Canvas Example</h1>

<canvas id=”canvas” width=”600” height=”500”>

</canvas>

</body>

</html>

Ο παραπάνω σκελετός κώδικα περιλαμβάνει την ετικέτα canvas, όπως
την ορίσαμε πρωτύτερα. Αλλά το τι θα ζωγραφίσουμε στον καμβά το προ-
γραμματίζουμε με javascript. Στο παράδειγμά μας, η ιδιότητα onload κα-
λεί τη συνάρτηση loader(), που εκτελείται κατά τη φόρτωση της ιστοσε-
λίδας στον πλοηγό και περιέχει τη ζωγραφική μας. Μέσα στη συνάρτηση
loader(), προσπελάζουμε τον καμβά με τις εντολές:

..

function loader() {

var canvas = document.getElementById(’canvas’);

var context = canvas.getContext(’2d’);

}

Η πρώτη εντολή μας λέει να βρούμε το αντικείμενο με id=”canvas” και
η δεύτερη να προσπελάσουμε το context αυτού του αντικειμένου. Όπως
ίσως μαντεύετε, μελλοντικά θα μπορούμε να ζωγραφίζουμε και τρισδιά-
στατα αντικείμενα, απλά αντικαθιστώντας το ”2d” με ”3d”. Για την ακρίβεια,
το 3d API ονομάζεταιWebGL και καλείται επίσης περνώντας το αλφαριθμη-
τικό ”webgl” (αντί για το ”3d”).

Από δω και πέρα, απλά… ζωγραφίζουμε.
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..

function loader() {

var canvas = document.getElementById(’canvas’);

var context = canvas.getContext(’2d’);

// House \\

context.fillStyle = ”rgba(0, 0, 200, 1)”;

context.fillRect(30, 50, 150, 130);

// Door \\

context.fillStyle = ”rgba(0, 200, 0, 0.5)”;

context.fillRect(80, 130, 50, 50);

// Roof \\

context.fillStyle = ”rgba(200, 0, 0, 1)”;

context.beginPath();

context.moveTo(30, 50);

context.lineTo(105, 0);

context.lineTo(180, 50);

context.closePath();

context.fill();

// Chimney

context.fillStyle = ”rgba(200, 0, 0, 1)”;

context.fillRect(140, 0, 25, 50);

// Windows

context.fillStyle = ”rgba(200, 200, 200, 1)”;

context.fillRect(60, 70, 40, 40);

context.beginPath();

context.moveTo(80, 70);

context.lineTo(80, 110);

context.moveTo(60, 90);

context.lineTo(100, 90);

context.closePath();

context.stroke();

context.fillStyle = ”rgba(200, 200, 200, 1)”;

context.fillRect(110, 70, 40, 40);

context.beginPath();

context.moveTo(130, 70);

context.lineTo(130, 110);

context.moveTo(110, 90);

context.lineTo(150, 90);

..

context.closePath();

context.stroke();

}

Ορίζετε το χρώμα γεμίσματος με τη συνάρτηση fillStyle, δίνοντας τις
τιμές RBGA (red [0-255], blue [0-255], green [0-255], alpha [0.0-1.0]), όπου
alpha=0.0 σημαίνει πλήρης διαφάνεια, δηλ. το συγκεκριμένο χρώμα δεν εμ-
φανίζεται.
Μπορείτε να σχεδιάσετε πολλά σχήματα πέραν του fillRect (ή του

strokeRect, αν δε θέλετε γέμισμα) που εμφανίζεται παραπάνω, όπως:

• arc(float centerx, float centery, float radius, float
startAngle, float endAngle, boolean anticlockwise);

• rect(float x, float y, float w, float h);

Π.χ.:

..

// Face \\

context.beginPath();

context.arc(275, 275, 50, 0, Math.PI * 2, true);

context.moveTo(310, 275);

context.arc(275, 275, 30, 0, 1.0 * Math.PI, false);

context.moveTo(265, 255);

context.arc(265, 255, 5, 0, 2 * Math.PI, false);

context.moveTo(295, 255);

context.arc(295, 255, 5, 0, 2 * Math.PI, false);

context.closePath();

context.stroke();

//nose

context.fillStyle = ”rgba(0, 200, 0, 0.5)”;

context.beginPath();

context.moveTo(275, 275);

context.lineTo(285, 285);

context.lineTo(265, 285);

context.closePath();

context.fill();
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Μπορείτε να δημιουργήσετε πολύπλοκα σχήματα με τις εντολές:

..

context.beginPath();

context.moveTo(x, y); // τo πινέλo είναι σηκωμένο

context.lineTo(x, y); // τo πινέλo ζωγραφίζει

context.closePath();

context.fill();

context.stroke();

Αλλά μη νομίζετε ότι περιορίζεστε μόνο σε γραμμές:

• bezierCurveTo(float cp1x, float cp1y, float cp2x,
float cp2y, float x, float y);

• quadraticCurveTo(float cpx, float cpy, float x, float
y);

όπου cp σημαίνει control point (σημείο ελέγχου)· η quadratic καμπύλη
χρειάζεται ένα, ενώ η bezier δυο σημεία ελέγχου.
Π.χ.:

..

// Heart

context.fillStyle = ”rgba(200, 0, 0, 1)”;

context.beginPath();

context.moveTo(275, 50);

context.bezierCurveTo(275, 47, 270, 35, 250, 35);

context.bezierCurveTo(220, 35, 220, 72.5, 220, 72);

context.bezierCurveTo(220, 90, 240, 112, 275, 130);

context.bezierCurveTo(310, 112, 330, 90, 330, 72);

context.bezierCurveTo(330, 72.5, 330, 35, 300, 35);

context.bezierCurveTo(285, 35, 275, 47, 275, 50);

context.closePath();

context.fill();

Τέλος, μπορείτε φυσικά να προσθέσετε κείμενο:

..

context.font = ’italic 32px sans-serif’;

context.fillText(”Καλή Χρονιά!”, 5, 400);

ή εικόνες:

• drawImage(HTMLImageElement image, float dx, float dy,
optional float dw, float dh);

όπου

..

var image = new Image();

image.onload = function() {

context.drawImage(image, sizeX, sizeY);

};

image.src = ’<ImageURL>’;

Υπάρχουν φυσικά πολλές ακόμα δυνατότητες, τις οποίες δε θα καλύ-
ψουμε στον περιορισμένο χώρο αυτού του άρθρου. Για περισσότερες πλη-
ροφορίες, ανατρέξτε στο ΑΡΙ ή στη βιβλιογραφία στο τέλος του άρθρου.
Εδώ, ο προσεχτικός αναγνώστης θα αναρωτηθεί: Αφού υπάρχει το πρό-

τυπο SVG που προσφέρει πολλές δυνατότητες για διανυσματικά γραφικά,
τι τον θέλουμε τον καμβά; Ο καμβάς παρέχει στατικά γραφικά, δηλ. χωρίς
αλληλεπίδραση με το χρήστη μέσω π.χ. του ποντικιού. Οπότε η απάντηση
είναι απλή: χρησιμοποιήστε τον καμβά για απόδοση και το SVG άμα χρειά-
ζεστε αλληλεπίδραση.
Δυστυχώς, κανένας από τους προαναφερθέντες κειμενογράφους δεν

διαθέτει (ακόμα) δυνατότητα ζωγραφικής στον καμβά με το ποντίκι και αυ-
τόματης μετατροπής σε κώδικα HTML 5, κάτι αντίστοιχο δηλ. του Inkscape
για SVG.

Βίντεο και ήχος

Συνεχίζοντας με την υποστήριξη πολυμέσων, θα δούμε πώς μπορούμε να
αναπαράγουμε βίντεο στον πλοηγό μας με τη βοήθεια της HTML 5:

..
<video [attributes]></video>

Η εντολή για αναπαραγωγή ήχου είναι:

..
<audio [attributes]></audio>

Όπου attributes:
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Παράμετρος audio/video Περιγραφή

autoplay audio/video Αυτόματη εκκίνηση βίντεο / ήχου κατά

την φόρτωση της σελίδας

controls audio/video Εμφάνιση της μπάρας εργαλείων

height video Ύψος πλαισίου βίντεο

width video Πλάτος πλαισίου βίντεο

loop audio/video Συνεχής επανεκκίνηση του βίντεο / ήχου

όποτε φτάνει στο τέλος του

src audio/video Διεύθυνση του αρχείου βίντεο/ήχου

poster video Διεύθυνση της εικόνας που εμφανίζεται

αν το βίντεο δεν είναι διαθέσιμο

preload audio/video Επιλογές προ-φόρτωσης του βίντεο/ή-

χου στον πλοηγό:

• none: δεν απαιτείται προ-φόρτωση

• metadata: ανάγνωση των μεταδε-

δομένων

• auto: ο πλοηγός αποφασίζει

Πίνακας 1: Ιδιότητες εντολών audio/video

Μπορείτε να βρείτε το πλήρες API για το βίντεο στη διεύθυνση:
http://www.w3.org/TR/html5/the-video-element.html,
ενώ το πλήρες ΑΡΙ για τον ήχο βρίσκεται στη διεύθυνση:
http://www.w3.org/TR/html5/the-audio-element.html.

• Πλοηγοί που τα υποστηρίζουν: Chrome, Firefox, Opera, Safari, Internet
Explorer 9.

Για την ώρα υποστηρίζεται μόνο η ανοικτού κώδικα μορφή αρχείου
.ogg. Αν θέλετε να φορτώσετε μια άλλη μορφή αρχείου (π.χ. .wmv,
.mpeg, κλπ.) και ο πλοηγός σας δεν την υποστηρίζει ακόμα, τότε μπο-
ρείτε να το μετατρέψετε σε μορφή .ogg, π.χ. μέσω των ιστοσελίδων:
http://www.mediaconverter.org/ ή http://www.online-convert.com/ .

Αφού έχετε επιλέξει το αρχείο βίντεο και το αρχείο ήχου που θέλετε
ν’ αναπαράγετε, αποθηκεύστε τον παρακάτω κώδικα στο αρχείο audio-
video.html και αντιγράψτε τα αρχεία βίντεο και ήχου στον ίδιο φάκελο:

..

<!DOCTYPE html>

<html>

<head><title>Audio/Video Example</title>

<script type=”text/javascript”>

function fail() {

switch (e.target.error.code) {

case e.target.error.MEDIA_ERR_ABORTED:

alert(’You aborted the playback.’);

break;

case e.target.error.MEDIA_ERR_NETWORK:

alert(’Network error.’);

break;

case e.target.error.MEDIA_ERR_DECODE:

alert(’Corruption problem.’);

break;

case e.target.error.MEDIA_ERR_SRC_NOT_SUPPORTED:

alert(’Format unsupported or file not found.’);

break;

default:

alert(’An unknown error occurred.’);

break;

}

}

</script>

</head>

<body>

<h1>Audio/Video Example</h1>

<video controls src=”myvideo.ogg” width=”400” height=”300”

onerror=”fail(event)”></video>

<br/>

<audio controls src=”myaudio.ogg” loop onerror=”fail(event)”>

</audio>

</body>

</html>
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Όπουmyvideo.ogg είναι το αρχείο βίντεο καιmyaudio.ogg το αρχείο ήχου
που θέλετε ν’ αναπαράγετε (αντικαταστήστε τα με τα δικά σας). Φυσικά,
μπορείτε να δοκιμάσετε και τις υπόλοιπες ιδιότητες: loop, preload,
autoplay, κλπ.

Φόρμες

Παραδοσιακά, η HTML υποστηρίζει τις ακόλουθες εντολές εισαγωγής δεδομένων μέσω φορμών:

Τύπος Εντολή HTML Εμφάνιση

Πλαίσιο Κειμένου <input name=”text” type=”text”/>

Κωδικός <input name=”password” type=”password”/>

Κουμπί <input type=”button” value=”Click me!”>

Κουμπί υποβολής <input type=”submit” value=”Submit”>

Κουμπί καθαρισμού <input type=”reset” value=”Clear”>

Λίστα <select name=”list”>

<option>Αχλάδι</option>

<option selected>Μήλο</option>

<option>Πορτοκάλι</option>

</select>

Κουμπί radio <input name=”radio” type=”radio”>Ναι</input>

Κουμπί Επιλογής <input name=”checkbox” type=”checkbox”>Συμφωνώ</input>

Περιοχή Κειμένου <textarea cols=”5” rows=”5” name=”textarea”></textarea>

Κρυμμένο κείμενο <input name=”hidden” type=”hidden”>

Εικόνα <input name=”image” alt=”email” src=”e-mail.gif”

type=”image” height=”60” width=”55”>

Ετικέτα <label for=”email”>Label</label> Label
Πίνακας 2: Εργαλεία εισαγωγής δεδομένων φορμών μέχρι την HTML 4.01
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Η HTML 5 προσθέτει πολλές νέες δυνατότητες εισαγωγής δεδομένων μέσω φορμών. Μόνο ο Opera, και λιγότερο ο Chrome, υποστηρίζουν μέχρι
στιγμής τις νέες εντολές κι αυτές όχι πλήρως. Για περισσότερες πληροφορίες, ανατρέξτε στις ιστοσελίδες http://www.w3.org/TR/html5/forms.html και
http://www.whatwg.org/specs/web-apps/current-work/multipage/the-input-element.html#attr-input-type.

Τύπος Εντολή HTML Εμφάνιση

Επιλογή Χρώματος <input name=”color” type=”color”/>

Ημερομηνία <input name=”date” type=”date”>

Ημερομηνία/ώρα <input name=”datetime” type=”datetime”>

Τοπική Ημερομηνία/ώρα <input name=”datetimelocal” type=”datetime-local”>

Μήνας <input name=”month” type=”month”>

Εβδομάδα <input name=”week” type=”week”>

Ώρα <input name=”time” type=”time”>

Αριθμός <input name=”number” type=”number” min=”1” max=”100” step=”5” value=”40”>

Εύρος Τιμών <input name=”range” type=”range” min=”0” max=”100” step=”5” value=”40”>

Διεύθυνση Η/Τ <input name=”email” type=”email”>

Διεύθυνση ιστοχώρου <input name=”url” type=”url”>

Πλαίσιο αναζήτησης <input name=”query” type=”search”>

Πίνακας 3: Νέα εργαλεία εισαγωγής δεδομένων φορμών στην HTML 5
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Ο παρακάτω κώδικας register.html δείχνει τη χρήση κάποιων απ’
αυτά σε σε μια χρήσιμη φόρμα εγγραφής:

..

<!DOCTYPE html>

<html>

<head><title>Εγγραφή</title></head>

<body>

<h1>Εγγραφή</h1>

<form method=”post” action=”register.php”>

<table border=”0” cellpadding=”5”>

<tr>

<td><label for=”name”>Όνομα</label></td>

<td><input name=”name” size=”30”

placeholder=”Enter your first name” autofocus>

</td>

</tr>

<tr>

<td><labelfor=”surname”>Επώνυμο</label></td>

<td><input name=”surname” size=”30”

placeholder=”Enter your surname”></td>

</tr>

<tr>

<td><label for=”email”>Email</label></td>

<td><input name=”email” type=”email” size=”30”

placeholder=”Enter your email” required></td>

</tr>

<tr>

<td><label for=”username”>Όνομα λογαριασμού</label></td>

<td><input name=”username” size=”16”

placeholder=”Enter your username” required></td>

</tr>

<tr>

<td><label for=”password”>Κωδικός</label></td>

<td><input name=”password” size=”16”

type=”password” placeholder=”Enter your password” required></

td>

</tr>

<tr>
..

<td><label for=”confirm-password”>Επιβεβαίωση Κωδικού</

label></td>

<td><input name=”confirm-password” size=”16”

type=”password” placeholder=”Confirm password” required></td>

</tr>

<tr>

<td><label for=”url”>Διεύθυνση ιστοχώρου</label></td>

<td><input name=”url” type=”url” placeholder=”Enter your

url”></td>

</tr>

<tr>

<td><label for=”date”>Ημερομηνία γέννησης</label></td>

<td><input name=”date” type=”date”></td>

</tr>

<tr>

<td><label for=”age”>Ηλικία</label></td>

<td><input name=”age” type=”number” min=”1”

max=”100” step=”5” value=”40”></td>

</tr>

<tr>

<td><label for=”query”>Χώρα</label></td>

<td><input name=”query” size=”30”

type=”search” placeholder=”Country of residence” list=”

countries”></td>

</tr>

<tr>

<td><label for=”zip”>ΤΚ..</label></td>

<td><input name=”zip” size=”5”

type=”text” pattern=”” placeholder=”Zip code”></td>

</tr>

<tr>

<td><label for=”color”>Αγαπημένο χρώμα</label></td>

<td><input name=”color” type=”color”></td>

</tr>

<tr>

<td><label for=”range”>Ποσοστό (0-100%)</label></td>

<td><input name=”range” type=”range”

min=”0” max=”100” step=”5” value=”40”></td>
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..

</tr>

</table><br/>

<input type=”submit” name=”Submit” value=”Υποβολή”>

<input type=”reset” name=”Reset” value=”Καθαρισμός”>

</form>

<datalist id=”countries”>

<option value=”Belgium”> </option>

<option value=”France”> </option>

<option value=”Italy”> </option>

<option value=”Germany”> </option>

<option value=”Greece”> </option>

<option value=”Spain”> </option>

</datalist>

</body>

</html>

Φυσικά, θα πρέπει να υπάρχει και κάποιος διακομιστής που θα επεξεργα-
στεί τα στοιχεία της φόρμας όταν πατήσετε το κουμπί Υποβολή. Αυτό γίνε-
ται από τον κώδικα register.php, ο οποίος όμως ξεφεύγει από το σκοπό
αυτού του άρθρου. Σημειώστε ότι, παρόλο που ο Opera έχει την καλύτερη
υποστήριξη γιαφόρμες τη στιγμή που γράφονται αυτές οι γραμμές, και πάλι
πολλά πράγματα δεν υποστηρίζονται ακόμα, π.χ. το μέγεθος των πεδίων ή
ο έλεγχος εγκυρότητας.

Επίλογος

Σ’ αυτό το άρθρο δώσαμε μια σύντομη εισαγωγή στην HTML 5 και πιο
συγκεκριμένα μιλήσαμε για τις νέες ευκολίες στη διαχείριση φορμών, ζω-
γραφικής, ήχου και βίντεο. Δυστυχώς, οι πλοηγοί δεν υποστηρίζουν ακόμα
πλήρως την HTML 5, αλλά αυτό δε σημαίνει ότι δεν μπορείτε να ξεκινήσετε
από τώρα να μαθαίνετε τις δυνατότητες της νέας αυτής έκδοσης της γλώσ-
σας που θ’ αλλάξει τον παγκόσμιο ιστό όπως τον ξέρουμε. Θα συνεχίσουμε
στο επόμενο τεύχος, περιγράφοντας και δίνοντας χρήσιμα παραδείγματα
χρήσης των υπόλοιπων ΑΡΙs.

Πηγές:

1. Flanagan D. (2010), Canvas Pocket Reference, O’Reilly.

2. Freeman E. & Robson E. (2011), Head First HTML5 Programming, O’
Reilly.

3. Geary D. (2012), Core HTML 5 Canvas, Prentice Hall.

4. Hawkes, R. (2011), HTML5 Canvas, Apress.

5. Holzner, P. (2011), Sams Teach Yourself HTML 5 in 10 minutes, Sams.

6. Osborn J. & AGI Training Team (2011), HTML5 Digital Classroom, Wiley.

7. Ιστολόγια: Robert Nyman, Christian Heilmann.

8. http://www.w3schools.com/html/html5_intro.asp

9. ZK (2012), 7 Useful HTML5 Editors for Web Development,
http://www.webtrafficroi.com/7-useful-html5-editors-for-web-develop
ment/ .

10. http://en.wikipedia.org/wiki/Comparison_of_HTML_editors.

11. https://github.com/bebraw/jswiki/wiki/Game-Engines.

12. http://www.html5canvastutorials.com/tutorials/html5-canvas-tutorials-
introduction/ .

13. http://css.dzone.com/articles/html5-code-snippets-take-your?mz=46483-
html5.

55

http://robertnyman.com/
http://christianheilmann.com/
http://www.w3schools.com/html/html5_intro.asp
http://www.webtrafficroi.com/7-useful-html5-editors-for-web-development/
http://www.webtrafficroi.com/7-useful-html5-editors-for-web-development/
http://en.wikipedia.org/wiki/Comparison_of_HTML_editors
https://github.com/bebraw/jswiki/wiki/Game-Engines
http://www.html5canvastutorials.com/tutorials/html5-canvas-tutorials-introduction/
http://www.html5canvastutorials.com/tutorials/html5-canvas-tutorials-introduction/
http://css.dzone.com/articles/html5-code-snippets-take-your?mz=46483-html5
http://css.dzone.com/articles/html5-code-snippets-take-your?mz=46483-html5


ClipGrab του Χρήστου Τριανταφύλλη

Ακούτε συχνά μουσική από το Youtube; Έχει τύχει να σας αρέσει το τρα-

γούδι που ακούτε; Είδατε κάποιο video στο Vimeo και σας άρεσε; Γιατί δεν

το κατεβάζετε λοιπόν; Εδώ έρχεται το Clipgrab και πραγματικά σας λύνει τα

χέρια!

Το Clipgrab μπορεί να κατεβάσει video από τους εξής διαδικτυακούς τό-

πους:

• YouTube

• Clipfish

• Collegehumor

• Dailymotion

• MyVideo

• MySpass

• Sevenload

• Tudou

• Vimeo

και να τα μετατρέψει στους ακόλουθους τύπους: WMV, MPEG4, OGG

Theora, MP3 (ήχος μόνο), OGG Vorbis (ήχος μόνο).

Το Clipgrab είναι αρκετά εύκολο στη χρήση, αφού σας δίνει τη δυνατό-

τητα να ψάξετε κατευθείαν από το ίδιο το πρόγραμμα στο Youtube, όπως

φαίνεται στην παρακάτω εικόνα:

κι έπειτα διαλέγετε τον τύπο στον οποίο θέλετε να αποθηκευτεί το video,

ενώ ακριβώς δίπλα την ποιότητα στην οποία θα αποθηκευτεί, όπως φαίνε-

ται στην εικόνα:
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Μπορείτε να διακρίνετε ότι δίνει την επιλογή για HD ανάλυση σε όποιο
site και video την υποστηρίζει. Στη συνέχεια απλά πατήστε στο “Grab this
clip” και το video θα αρχίσει να κατεβαίνει!
Η διαδικασία είναι αρκετά απλή και μπορείτε ακόμα από τις ρυθμίσεις να

καθορίσετε σε ποιον φάκελο θα αποθηκεύονται τα video, αν θα χρησιμο-
ποιούνται μεταδεδομένα, καθώς επίσης και να αλλάξετε κάποιες επιλογές
που αφορούν το Clipgrab, ή ακόμα και ρυθμίσεις proxy.
Μπορείτε να εγκαταστήσετε το Clipgrab κατεβάζοντας το πακέτο από το

site του, είτε μέσω του αποθετηρίου που διατηρεί:

..

sudo apt-add-repository ppa:clipgrab-team/ppa

sudo apt-get update

sudo apt-get install clipgrab
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Κοινωνική Δυκτύωση με Gwibber & Empathy του Γιώργου Καντιάνη

Empathy-Gwibber

Σίγουρα, είναι δύο εφαρμογές που οι λάτρεις της ηλεκτρονικής κοινωνι-

κής δικτύωσης γνωρίζουν εδώ και χρόνια! Πλέον, στο Ubuntu 12.10 ενώ-

νουν τις δυνάμεις τους, δημιουργώντας το τέλειο περιβάλλον με πολλαπλά

πρωτόκολλα επικοινωνίας. Όλα σε ένα μαγικό εικονίδιο → Έτσι πατώ-

ντας αυτό το κουμπί, βλέπουμε τα εξής:

Το Empathy για συνομιλίες, το Thunderbird για ταmail μας και το Gwibber

για νέα και μηνύματα από τα πρωτόκολλα επικοινωνίας που χρησιμο-

ποιούμε.

Empathy

Το Empathy είναι πλέον ένα από τα καλύτερα προγράμματα άμεσων μη-

νυμάτων.

Παλιότερα, ελάχιστοι χρήστες προτιμούσαν το Empathy λόγω της άσχη-

μης εμφάνισής του. Ωστόσο, στην τελευταία του stable έκδοση διόρθωσε

αισθητά αυτό το μεγάλο του μειονέκτημα. Έτσι το προτίμησε και το Ubuntu

για προεπιλεγμένο πρόγραμμα.
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Υποστηρίζει ομαδικές συνομιλίες, χρήση πολλών λογαριασμών ταυτό-
χρονα, φωνητική κλήση και βιντεοκλήση. Μπορείτε να το εγκαταστήσετε
από το κέντρο λογισμικού Ubuntu αλλά και από το τερματικό:

..
sudo apt-get install empathy

Gwibber

Άλλη μια αξιοθαύμαστη εφαρμογή ανοιχτού κώδικα. Με αυτή μπορείτε
να βλέπετε όλα τα νέα σας από διάφορα πρωτόκολλα επικοινωνίας ταυ-
τόχρονα. Ήταν και είναι πολύ φιλικό προς τον απλό χρήστη και αγαπημένο
πρόγραμμασχεδόνόλων τωνχρηστών τουLinux. Τα νέαανανεώνονται όσο
συχνά θέλετε μέσω των ρυθμίσεων, ενώ στο Ubuntu 12.10 απέκτησε μια
νέα καινοτομία.

Την εμφάνιση των νέων στον πάνω δεξί μέρος της οθόνης.

Για την εγκατάσταση τουπρογράμματος, επισκεφθείτε το κέντρο λογισμι-
κού του Ubuntu ή μέσω τερματικού:

..
sudo apt-get install gwibber

Συγχρονισμός των λογαριασμών σας

Στο Ubuntu 12.10 είναι μια πολύ εύκολη διαδικασία. Πηγαίνουμε στις
Ρυθμίσεις συστήματος και επιλέγουμε Διαδικτυακοί Λογαριασμοί. Θα
ανοίξει το διπλανό παράθυρο. Πατάμε Πρόσθεση λογαριασμού και διαλέ-
γουμε το πρωτόκολλο επικοινωνίας που χρησιμοποιούμε, ώστε να συγχρο-
νιστεί με το Gwibber και το Empathy.

Αυτά είναι όλα όσα πρέπει να ξέρετε για τα δύο αυτά προγράμματα.
Ελπίζω η παραπάνω παρουσίαση να σας φάνηκε χρήσιμη.
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FreeGish του Χρήστου Τριανταφύλλη

Το παιχνίδι

Το FreeGish μπορείτε να το βρείτε στο κέντρο λογισμικού αλλά και στην

σελίδα του και είναι ένα από τα παιχνίδια που θα σας συνιστούσα αν θέλετε

να περάσει ευχάριστα ο χρόνος.

Αποτελεί μια έκδοση ανοιχτού κώδικα του παιχνιδού Gish. Είναι παιχνίδι

βασισμένοστηφυσική, όπουοχαρακτήραςπουπαίζετε είναι μιαμπάλααπό

...πίσσα! Ναι, καλά διαβάσατε, πίσσα!

Σκοπός του παιχνιδιού είναι να περάσετε τις πίστες χρησιμοποιώντας τις

τρεις ικανότητες του Gish, δηλαδή είτε να γίνεστε γλοιώδης και να προχω-

ράτε μέσα από στενά δρομάκια ή περάσματα, είτε να βγάζετε ...καρφιά και

να σκαρφαλώνετε σε τοίχους, είτε να γίνεστε σκληρός σαν σίδερο.

Δεν υπάρχουν πολλά να περιγράψω, καλύτερα να το παίξετε! Το παιχνίδι

είναι αρκετά διασκεδαστικό και ίσως σας παιδέψει και λίγο σε κάποια ση-

μεία (ακόμα δεν μπορώ να περάσω μια συγκεκριμένη πίστα :@ ), αλλά είναι

αρκετά καλό για να περάσετε τον χρόνο σας.

FreeGish
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Τρισδιάστατη εκτύπωση και LEGOMindstorms:
H συνέργεια ΕΛ/ΛΑΚ, ανοικτού υλικού και ομότιμων πρακτικών του Bασίλη Kωστάκη

Tις δύο τελευταίες δεκαετίες πολλοί έχουν ισχυριστεί ότι ολοένα και με-

γαλύτερος αριθμός ανθρώπων είναι ικανός να οργανώνει τις πολιτικές, κοι-

νωνικές και παραγωγικές εκφάνσεις της ζωής του μέσα από ποικίλα αλλη-

λοσυνδεόμενα δίκτυα τα οποία ήρθαν στο προσκήνιο με τις σύγχρονες Τε-

χνολογίες Πληροφορικής και Eπικοινωνίας (TΠE) και την ευρεία διαθεσιμό-

τητα αυτών λόγω του χαμηλού κόστους απόκτησης. Mέσα από αυτό το νέο

πλαίσιο επικοινωνίας, αναδύεται ένα καινούριο μοντέλο κοινωνικής παρα-

γωγής, ριζικά διαφορετικό από το κυρίαρχο βιομηχανικό, η βασισμένη στα

Kοινά ομότιμη παραγωγή.

Aντιπροσωπευτικά παραδείγματα πληροφοριακών Kοινών ομότιμης πα-

ραγωγής αποτελούν τα εγχειρήματα Eλεύθερου Λογισμικού/Λογισμικού

Aνοικτού Kώδικα (ΕΛ/ΛΑΚ), το ανοικτό υλικό (open hardware, π.χ. ο micro-

controller Arduino ή ο τρισδιάστατος εκτυπωτής RepRap) και η ελεύθερη

διαδικτυακή εγκυκλοπαίδεια Wikipedia, όπου οι άνθρωποι συνεργάζονται

εθελοντικά για την επίτευξη ενός συγκεκριμένου σκοπού. H ομότιμη παρα-

γωγή μπορεί να θεωρηθεί ως ένας νέος τρόπος παραγωγής, ο οποίος κατέ-

στη δυνατός μέσω του διαδικτυακού συντονισμού, όπου οι αποφάσεις και

δράσεις πηγάζουναπό την ελεύθερη, χωρίς καταναγκασμόσυνεργασία των

ανθρώπων που συμμετέχουν στη δημιουργία κοινής αξίας χωρίς να έχουν

ως πρωτεύον κίνητρο το χρηματικό κέρδος.

Σε αυτό το πλαίσιο, οι τεχνολογικές δυνατότητες της τρισδιάστατης εκτύ-

πωσης – δηλ. η δυνατότητα κατασκευής υλικών αντικειμένων από τρισ-

διάστατα ψηφιακά μοντέλα με τη μέθοδο της “προσθετικής κατασκευής”

(additive manufacturing) – έχουν ιδιαίτερο ενδιαφέρον. Kι αυτό διότι φαί-

νεται να μεταφέρουν κάποιες από τις δυναμικές της ομότιμης παραγω-

γής στην υλική παραγωγή, καθιστώντας εν δυνάμει τον καθένα σχεδια-

στή/παραγωγό/διανομέα/καταναλωτή. Θα μπορούσαμε να ισχυριστούμε

ότι τα ολοένα και χαμηλότερα κόστη απόκτησης ενός τρισδιάστατου εκτυ-

πωτή δίνουν την ευκαιρία σε χομπίστες και ανήσυχους δημιουργούς να πει-

ραματιστούν, να σχεδιάσουν, να παράξουν και να μοιραστούν λειτουργικά

σχέδια και προϊόντα ανοικτά σε περαιτέρω τροποποίηση και αναβάθμιση.

Ένας από αυτούς τους “ανήσυχους δημιουργούς” είναι και ο 15χρονος

Mάριος Παπαχρήστου, μαθητής πρώτης λυκείου από την Aθήνα, ο οποίος

αναπτύσσει έναν τρισδιάστατο εκτυπωτή ανοικτού κώδικα χρησιμοποιώ-

ντας τα LEGO Mindstorms. Το έργο αυτό είναι εμπνευσμένο από τα σχέ-

δια του ομότιμα σχεδιασμένου τρισδιάστατου εκτυπωτή RepRap και την

3D φρέζα του Arthur Sacek. O Mάριος, σε συνεργασία με το P2P Lab, σκο-

πεύει μέσωαυτής της προσπάθειας να δείξει τι μπορεί να επιτευχθεί όταν οι

άνθρωποι – και πόσω μάλλον ένας μαθητής λυκείου – έχουν πρόσβαση σε

ανοικτά/ελεύθερα μέσα παραγωγής (λογισμικό, σχέδια, ανοικτό υλικό, συ-

ναρμολογούμενα LEGO). Mαζί με τον Mάριο, λοιπόν, ελπίζουμε να αναδεί-

ξουμε τις δυναμικές από τη συνεργεία της προσαρμοστικότητας των LEGO

με τα προϊόντα και τις πρακτικές της ομότιμης παραγωγής.

Περισσότερες πληροφορίες για το υπό εξέλιξη έργο μπορείτε να βρείτε

στο http://code.google.com/p/lego-mindstorms-3d-printing-machine/ .

Mερικές φωτογραφίες:
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Απολογισμός 2012 - Ubuntu-gr του Νίκου Θ.

Την χρονιά που πέρασε (2012), διάφορα γεγονότα συνέβησαν στην Ελλη-

νική κοινότητα του Ubuntu. Εξελίξεις, αλλαγές, ανακατατάξεις... Στο άρθρο

που ακολουθεί, θα δούμε έναν απολογισμό με τα σημαντικότερα γεγονότα

που απασχόλησαν την Ελληνική κοινότητα Ubuntu.

Release Party Ubuntu 12.04 και 12.10

Όπως με κάθε νέα έκδοση Ubuntu, έτσι και με την έκδοση 12.04 LTS (που

κυκλοφόρησε τον Απρίλιο του 2012) καθώς και με την 12.10 (που κυκλοφό-

ρησε τονΟκτώβριο του2012), η ΕλληνικήκοινότηταUbuntuδιοργάνωσε τα

Release Party στην Αθήνα. Τα release party της Αθήνας έλαβαν χώρα στο

Ηλιοστάσιο (έναν χώρο – καφετέρια στο Θησείο), φυσικά κατόπιν ανοιχτής

ψηφοφορίας όπου ψήφισαν όλα τα μέλη της κοινότητας.

Αντίστοιχα party διοργανώθηκαν από άλλες φιλικές προς το Ubuntu κοι-

νότητες σε Λαμία και Θεσσαλονίκη.

Μπορείτε να δείτε φωτογραφίες και υλικό στην κεντρική σελίδα Ubuntu-

gr (http://ubuntu-gr.org/photogallery).

Αλλαγή Loco Contact

Ο Loco Contact είναι το άτομο το οποίο είναι υπεύθυνο για πολλά πράγ-

ματα ταυτόχρονα. Αναλαμβάνει να συνεννοηθεί για την παραλαβή όλων

των αντικειμένων που δικαιούται μια επίσημα εγκεκριμένη κοινότητα του

Ubuntu (όπως η Ελληνική), οργανώνει τα release party, παραγγέλνει τα CD-

DVD, κλπ.

Φέτος είχαμε μια αλλαγή και πλέον Loco Contact για την Ελληνική κοινό-

τητα Ubuntu είναι ο Γιώργος Χριστοφής (aka Geochr).

Καλή δύναμη!

Αλλαγές στην συντονιστική ομάδα

Μετά από απόφαση των συντονιστών και διαχειριστών του φόρουμ

πως χρειάζονται περισσότεροι συντονιστές, άνοιξε μιαψηφοφορία για προ-

σθήκη μελών στην συντονιστική ομάδα.

Η ανάγκη συντονιστών για το φόρουμ ήταν εμφανής, καθότι άλλοι εί-

χαν αποχωρήσει και άλλοι δεν συμμετείχαν ενεργά (λόγω προσωπικών ή

άλλων υποχρεώσεων). Όλα αυτά βέβαια είναι απολύτως δεκτά και κατα-

νοητά, όμως η ομάδα τωνσυντονιστών ήθελε κι άλλα μέλη για να συνεχίσει

το έργο της.

Η ψηφοφορία άνοιξε στις 2 Ιουνίου του 2012 και έκλεισε στις 20 Ιουνίου

2012. Ψήφισαν (όπως και κάθε φορά άλλωστε) ΟΛΑ τα μέλη του φόρουμ.

Οι νέοι συντονιστές που εκλέχθηκαν είναι οι Konnn, Learner και Ubuderix.

Καλή δύναμη τους ευχόμαστε!
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Μετεωρολογικός σταθμός στην Ήπειρο

Με τη βοήθεια της Ελληνικής κοινότητας Ubuntu, το μέλος Lepidas

έστησε ένανολόκληρομετεωρολογικόσταθμόστηνΉπειρο.Όσοι ενδιαφέ-

ρονται για το συγκεκριμένο σημείο και τις θερμοκρασίες που επικρατούν,

μπορούν να επισκεφτούν την σελίδα του σταθμού. Επίσης, έχουν την δυνα-

τότητα για ζωντανή παρακολούθηση καιρικών φαινομένων μέσω Live κά-

μερας. Μπορείτε να παρακολουθήσετε την προσπάθεια που έγινε, στο φό-

ρουμ της κοινότητας.

Αλλαγή δίσκου Server

Από καιρό θέλαμε να αλλάξουμε δίσκο στον Server της κοινότητας, κα-

θότι αυτός που είχαμε παρουσίαζε, φανερά πλέον, σημάδια κόπωσης. Ψά-

χναμε να βρούμε κάποιον που να ταιριάζει, αλλά και κάποιον που να είναι

προσιτός στην τιμή. Τελικά η λύσηήρθεαπό τοKlug που εκτός τουότι βρήκε

δίσκο στα μέτρα μας... τον πρόσφερε και Εντελώς Δωρεάν. Ευχαριστούμε

το Klug για την προσφορά του!

Εκτύπωση T-Shirt

Για πρώτη φορά φέτος η Ελληνική κοινότητα Ubuntu-gr πήρε την πρωτο-

βουλία και εκτύπωσε μπλουζάκια με το λογότυπό της. Άνοιξε σχετικό θέμα

στο φόρουμ όπου παρατέθηκαν διάφορα σχέδια, επιλέχθηκε κάποιο σχέ-

διο και η εκτύπωση ήταν πλέον γεγονός. Να σημειώσουμε πως η συμμετοχή

μελών ήταν μεγαλύτερη από την αναμενόμενη και εκτυπώθηκαν περί τα 42

μπλουζάκια.

Καλοφόρετα!

Events

Πολλά events και εκδηλώσεις διεξήχθησαν την χρονιά που πέρασε.Μέλη

της Ελληνικής κοινότητας του Ubuntu ήταν εκεί, παρουσιάζοντας και διαδί-

δοντας το αγαπημένο λειτουργικό σύστημα.

• Ubuntu Global Jam Αθήνα 3/2012

• Καστοριά Ημερίδα Ubuntu 17/3/2012

• FOSSCOMM 2012

• Ανοιχτή πρόσκληση του Δήμου Κορωπίου σε νέες τεχνολογίες, linux κτλ

• Tech Kids Day

Μπορείτε να βρείτε υλικό και φωτογραφίες στην κεντρική σελίδα

Ubuntu-gr.org.

Επανέγκριση της Ελληνικής κοινότητας

Οι κοινότητες Ubuntu υπάρχουν σε όλο τον κόσμο, ωστόσο δεν είναι

όλες εγκεκριμένες από την Canonical (την εταιρία πίσω από το Ubuntu).

Η έγκριση των κοινοτήτων ως Επίσημες κοινότητες του Ubuntu σε κάποια

χώρα έχει ως αποτέλεσμα να λαμβάνουν σε κάθε νέα έκδοση Ubuntu κά-

ποια CD – DVD, καθώς και άλλα διαφημιστικά αντικείμενα, όπως επίσης και

επίσημα έντυπα, βιβλία, κλπ.

Η Ελληνική κοινότητα είναι η επίσημη κοινότητα Ubuntu στην Ελλάδα.

Όμως η έγκριση δεν είναι μόνιμη και αμετάκλητη. Κάθε 2 χρόνια γίνεται

ψηφοφορία από εκλεγμένα μέλη της Canonical και πρέπει η εκάστοτε κοι-

νότητα να παρουσιάσει έργο για να εγκριθεί ξανά.

Η Ελληνική κοινότητα κατάφερε και φέτος να επανεγκριθεί, παρουσιά-

ζοντας το έργο που έχει κάνει τα χρόνια που πέρασαν από την τελευταία

έγκρισή της.

Διαβάσετε περισσότερα για την διαδικασία στο φόρουμ.
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Μεταφραστική Ομάδα

Γνωρίζουμε όλοι πως η μεταφραστική ομάδα του Ubuntu-gr έχει κάνει

ένα τεράστιο έργο. Όλες οι εκδόσεις Ubuntu που μπορούμε και απολαμβά-

νουμε στην μητρική μας γλώσσα είναι αποτέλεσμα της δουλειάς που κάνει

η μεταφραστική ομάδα της κοινότητας.

Το έργο μπορεί να χαρακτηριστεί άνετα κολοσσιαίο, καθώς χιλιάδες

γραμμές πρέπει να μεταφραστούν και να παραδοθούν στην ώρα τους, έτσι

ώστε να συμπεριληφθούν στις νέες εκδόσεις Ubuntu.

Ίσως δεν είναι ανάγκη να το αναφέρουμε, αλλά για όσους τυχόν δεν το

ξέρουν όλα γίνονται εθελοντικά, με μόνο κίνητρο την προσφορά και την

αγάπη για το λειτουργικό σύστημα Ubuntu.

Και φέτος η μεταφραστική ομάδα της Ελληνικής κοινότητας Ubuntu κα-

τάφερε να μεταφράσει πλήρως τις εκδόσεις 12.04 LTS και 12.10, καθώς εί-

ναι σε εξέλιξη (και σχεδόν ολοκληρωμένη) και η μετάφραση του Ubuntu

Manual, το οποίο είναι το πληρέστερο εγχειρίδιο για τις εκάστοτε εκδόσεις

Ubuntu.

Καλή δύναμη και Ευχαριστούμε!

Ubuntistas στο Κέντρο Λογισμικού

Το περιοδικό της Ελληνικής κοινότητας Ubuntu. Ένα δωρεάν περιοδικό

που εκδίδεται περίπου κάθε δυο μήνες και είναι και αυτό αποτέλεσμα εθε-

λοντικής δουλειάς της ομάδας Ubuntistas.

Αρθρογράφοι – Επιμελητές – Συντονιστές – Σελιδοποιητές, όλοι δουλεύ-

ουν (εθελοντικά πάντα) για να υπάρχει διαθέσιμο το περιοδικό στην ώρα

του. Όμως κάτι πλέον έχει αλλάξει: το περιοδικό βρίσκεται στο Κέντρο Λο-

γισμικού του Ubuntu. Στο Software Centre, εκεί όπου βρίσκονται εφαρμο-

γές και έντυπα εγκεκριμένα από την Canonical και τους υπεύθυνους του Κέ-

ντρουΛογισμικού. Άρα, μπορείτε πλέον να τοπρομηθεύεστεαπευθείαςαπό

την διανομή Ubuntu που έχετε, απλά ανοίγοντας το Κέντρο Λογισμικού και

ψάχνοντας για: Ubuntistas.

Συγχαρητήρια στην Ομάδα Ubuntistas!

Διακρίσεις μελών της Ελληνικής κοινότηταςUbuntu-gr

Τον Ιούνιο του 2012 η Canonical ανακοίνωσε ένα διαγωνισμό νέων εφαρ-

μογών, όπου οι νικητές εκτός από τα δώρα, θα έβλεπαν και την εφαρμογή

τους στο Κέντρο Λογισμικού του Ubuntu.

Οι όροι ήταν ξεκάθαροι. Νέα Εφαρμογή (όχι επεξεργασία κάποιας υπάρ-

χουσας) και 3 εβδομάδες διορία.

Εκατοντάδες εφαρμογές – εκατοντάδες προγραμματιστές απ’ όλο τον κό-

σμο έλαβαν μέρος στον διαγωνισμό. Υπήρξε σχετική ανακοίνωση στο φό-

ρουμ της Ελληνικής κοινότητας Ubuntu σχετικά με τον διαγωνισμό και κά-

ποια μέλη (προγραμματιστές) εκδήλωσαν ενδιαφέρον.

Τοπέρας τουδιαγωνισμούήρθεκαι τααποτελέσματαανακοινώθηκανκαι

να που δυο μέλη της Ελληνικής κοινότητας ήταν στις πρώτες θέσεις. Συγκε-

κριμένα ο Clepto με το πρόγραμμα MangaR (ένας Reader για όσους αγα-

πούν τα Manga) και ο Evolgen με το πρόγραμμα Orthcal (Ορθόδοξο Εορτο-

λόγιο).

Πιο συγκεκριμένα, ο Evolgen κατέλαβε την 2η θέση και ο Clepto την 4η.

Οι εφαρμογές και των δυο συμπεριλαμβάνονται πλέον στο Κέντρο Λο-

γισμικού του Ubuntu. Απλά ψάξτε με τα αντίστοιχα ονόματα: Orthcal ή

MangaR για να τις βρείτε και να τις εγκαταστήσετε.

Επίσης, φέτος είχαμε και προσθήκη ενός μέλους στην ομάδα Ubuntu

Members. Ubuntu Member γίνεται κάποιος που κρίνεται πως έχει προσφέ-

ρει ικανοποιητικά στην κοινότητα Ubuntu μέσα από μια συνεχή και αδιά-

κοπη συμμετοχή σε διάφορα projects. Ο Learner κατάφερε φέτος κι έγινε

Ubuntu Member.

Μπορείτε να δείτε την διαδικασία σχετικά με το πώς γίνεται κάποιος

Ubuntu Member εδώ.

Συγχαρητήρια σε όλους!!
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10.000 μέλη στο φόρουμ

Κάποτε, το 2008, κάποιοι είχαν μια ιδέα. Να ανοίξουν ένα φόρουμ για

το Ubuntu. Το λειτουργικό σύστημα που χρησιμοποιούσαν, που αγαπούσαν

και που η φιλοσοφία του (ΕΛ/ΛΑΚ) αντικατόπτριζε τα πιστεύω τους για την

ελευθερία που πρέπει να παρέχει στον χρήστη ένα λειτουργικό σύστημα.

Σήμερα, εν έτη 2012, αυτό το φόρουμ που ξεκίνησε απλά ως ένας διαδι-

κτυακός τόπος ανταλλαγής απόψεων και ιδεώνφιλοξενεί 10.000 μέλη. Έχει

μετεξελιχθεί σε έναν χώρο επίλυσης προβλημάτων, βοήθειας νέων χρη-

στών - αρχάριων στο Ubuntu – διαθέτει εκατοντάδες οδηγούς (tutorials),

δικό του σχολείο μαθημάτων για γλώσσες προγραμματισμού, δεκάδες ενό-

τητες με εκατοντάδες θέματα και χιλιάδες δημοσιεύσεις.... και όλα αυτά

οφείλονται στους χρήστες, στα μέλη του φόρουμ που δεν σταματούν να

δημοσιεύουν, δεν σταματούν να βοηθούν, δεν σταματούν να ασχολούνται

με αυτό που πιστεύουν και τους αρέσει … το UBUNTU.
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To περιοδικό Ubuntistas σε χρειάζεται!

Για να μπορέσει να συνεχίσει να λειτουργεί το περιοδικό μας, όπως κα-
ταλαβαίνετε, χρειάζεται συνεχώς άρθρα.
Αν έχετε κάποια ιδέα, πρόταση για τη βελτίωση του περιοδικού ή θέ-
λετε να συνεισφέρεται γράφοντας άρθρα, ή ακόμη αν επιθυμείτε να
ενταχθείτε στην ομάδα του περιοδικού, μπορείτε να μπείτε στο:
http://ubuntistas.ubuntu-gr.org/index.php/contact
και να μας στείλετε ένα e-mail.
Eναλλακτικά, μπορείτε να εκδηλώσετε ενδιαφέρον για σύνταξη ενός
άρθρου στο θέμα:
http://forum.ubuntu-gr.org/viewtopic.php?f=35&t=21721.
Για περισσότερες πληροφορίες μπορείτε επίησης να στείλετε μήνυμα
στην ομάδα ubuntistas μέσω του φόρουμ της ελληνικής κοινότητας
Ubuntu-gr και να επικοινωνήσετε μαζί μας!
Το περιοδικό είναι διαθέσιμο από την ιστοσελίδα:
http://ubuntistas.ubuntu-gr.org
καθώς και μέσω του Κέντρου λογισμικού του Ubuntu.

http://ubuntistas.ubuntu-gr.org/index.php/contact
http://forum.ubuntu-gr.org/viewtopic.php?f=35&t=21721
http://ubuntistas.ubuntu-gr.org

